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第一章 パッケージソフトの説明と開発ボードのテスト 

 

パッケージソフトウェアに主に含むものを紹介する。 

1.1 パッケージソフトの説明 

 

1) CP210x_Windows_Drivers.zip  シリアルドライバー  

2) Xilinx_Vivado_SDK_2017.4_1216_1.tar.gz  Vivado 2017.4 インストールパッケージ  

 これは Windows と Linux が通用するバージョン。Windows を使う場合、解凍ソフトが必要になる 

3) petalinux-v2017.4-final-installer.run petalinux インストールパッケージ 

4) qt-opensource-windows-x86-mingw530-5.7.1.exe  Windows バージョンＱｔ 

5) qt-opensource-linux-x64-5.7.1.run Linux バージョンＱｔ 

6) imageUSB.exe ミラーリカバリーツール 

7) 00_resource  中に Linux のソースコード、ルートファイルシステムが含まれている 

8) VMware-workstation-full-12.1.1-3770994.exe バーチャルマシンインストールパッケージ 

9) ubuntu-16.04.3-desktop-amd64.iso  Ubuntu のインストールパッケージ、PC だけにインストール

できる。開発ボードにはインストールできない 

 

1.2 開発ボードテスト 

 

開発ボードを手に入れ、正常に働けるかどうかをテストする。これから、簡単に行えるテストを紹介

する。 

 

1.1.2 テストに必要なもの 

1) コンピューター 
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2) 解像度は1920×1080より高い、HDMIをサポートするモニターをもう一台を用意してください。

電源なしで HDMI から VGA コンバーターを変換することは開発ボードがサポートできないので、給電が

独立なコンバーター需要である。 

 

3) HDMI ケーブル一つ 

オーディオインタフェース 

 

電源コンセン

ト 

 

VGA インタフェース 

HDMI インタフェース

*2 
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4) USB ポートのマウスとキーボード 

 

 

5）ルーター 

ネットワークをテストするため、インターネットを繋いたほうがいい。DHCP をサポートする。 

 

6）LAN ケーブル 
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1.2.2 開発ボードのケーブル接続 

1）HDMI モニターと接続 

2）LAN ポートはルーターと接続する 

3)  電源を接続 

 

 

 

1.2.3 テストする 

 

1)  テスト前、USB からシリアルポートへの変換のドライバソフト(ソフト/CP210x_Windows_   

Driver_zip）をインストールください。そうしなければ、シリアル通信テストができない。インストー

ル完了後、USB ケープルを使い、コンピューターの USB ポートと開発ボードの UART ポート（J1）をコ

ネクトしてください。これから、コンピューターのデバイスマネージャを開き。そこでシリアル設備

CP210x がみつけられる。サンプルでは COM3。 

 

USB to シリアルポートはコンピューターの USB と接続 

 
ケープルはル

ーターと接続 

 USB ポーのマウスとキーボード 

 

5V 電源 

 

電源スイッ

チ 

 

HDMI はモニターと接続 
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2)  ターミナルツールはたくさんある。例えば、putty、tetaterm、Windows 内部のターミナルツール

と SecureCRT などである。ここでは putty を利用する。 

3)  Serial と Serial line で COM3 を選んで、スビートは 115200 を書いてください。COM3 のシリア

ルナンバーはデバイスマネージャで表示されたものと同じく書いて、“Open”をクリックしてください。 

 

 

 

4)   開発ボードの起動モードは SD モードかどうかを確認する（出荷時、デフォルトで開発ボードの

カードスロットにカードがある、スタートモードも SD モードがデフォルト値になっている)、ジャンパ

ーでスタートモードを変更できる。 
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5)  開発ボードの電源スイッチを入れて、putty の画面では u-boot と Linux システムのスタートメッ

セージが表示される。 

 

6)  シリアルターミナルでシステムに登録できる。ユーザー：root、パスワード：root 

    大勢な人は putty を使用するのが初めて、あるいは、初めてシリアルを使うのである。説明しな

ければならないのは、putty でコマンドの入力はホストキーボードで実現する。開発ボードと接続して

いるキーボードではない。 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  13  

 

 

7)  起動した後、開発ボードと接続している HDMI モニターは Debian のデスクトップが表示される。

パネルを選択するの画面が出る場合、デフォルトパネルを選んでいい。 
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8)  ここに来て、もうマウスとキーボードを使って、操作出来る。マウスで Web ブラウ 

    ザーをダブルクリックしてください。ブラウザーの起動は時間がかかりますので、し 

    ならくお待ちください。 

 

9)  アドレス欄で URL を入力してください。正常に開けば、開発ボードはもう普通に使える。 

 

10)  開発ボードの簡易テストはここで終了する。 
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第二章 ZYNQ の紹介 

 

  Zynq シリーズの特長は FPGA にある完璧な ARM サブシステム(PS)である。各 Zynq システムのプ

ロセッサーは Cortex-A9 プロセッサーが含んでいて、プロセッサーの構造は全部これを中心にしてい

る。そして、サブシステムにメモリーコントローラと大量なペリフェラル統合されていて、Cortex-A9

のコアが Zynq-7000 内でプログラマブルロジックユニットから独立できるようになった。つまり、し

ばらくの間で、プログラマブルロジックユニット（PL）を使っていなければ、ARM プロセッサーのサ

ブシステムも独立で働ける。これは以前の FPGA と本質的な違いがあり、プロセッサーを中心にして

います。 

 Zynq は PS 部分と PL 部分、二つの機能ブロックである。はっきり言うと、ARM の SOC 部分と、FPGA

部分である。その中に、PS は二つの ARM Cortex™-A9 プロセッサー、AMBA®の相互連結、内部メモリ、

外部メモリとペリフェラルを統合している。ペリフェラルの方は主に USB バスインターフェス、イー

サネットインタフェース、SD/SDIO インタフェース、I2C バスインターフェス、CAN インタフェース、

UART インタフェースと GPIO などを含んでいる。 

 

 

 

 

 

 

 

 

 

 

 

 

 

ZYNQ チップの全体ブロック図 

 

 

   PS：プロセッシングシステ（Processing System）、FPGA と無関連の ARM の SOC 部分。 

   PL：プログラマブルロジック、FPGA 部分。 

 

2.1 PS と PL の相互連結技術 

 

  ZYNQ は高性能 ARM Cortex-A9 シリーズと高性能 FPGA をシングルチップで厳密に結びつける製品

である。AMR プロセッサーと FPGA との高速通信とデータ交換を実現し、両方の性能優位を発揮する

ため、効率が高いチップ内高性能プロセッサーと FPGA の連絡通路が需要である。そのため、効率が

高い PL と PS のだデータ交換通路を設計することは ZYNQ チップの設計で最も重要なことと同時に、
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製品の設計が成功できるかどうかに関わっている。この節、弊社が紹介する内容は主に PS と PL の連

結で、ユーザーに連結技術を了解させる。 

 実は、具体的な設計には、連結での工夫はそんなに多くない。IP コアを加わったあと、システ

ムは自動的に AXI インタフェースを使って、弊社の IP コアとプロセッサーを連結する。あとは少し

補充すればいい。 

 AXI のフルネームは Advanced eXtensible Interface で、Xilinx がシリーズ 6 の FPGA から導

入するインタフェースプロトコルである。主にメインデバイスとサブデバイスのデータエントリー方

法を説明した。ZYNQ で使っているバージョンは AXI4 であるから、AIX4.0 と ZYNQ の内部デバイスに

AXI インタフェースがあることをよく見られる。実際に、AXI は ARM 会社が提出していた

AMBA(Advanced Microcontroller Aechitecture)の一部で、高性能、高帯域幅とローディレイのチ

ップインタナルバスである。これも前の AHB と APB バスの代わりになっている。初代パッジョン

AXI(AXI3)は 2003 でリリースされた AMBA3.0 に、二代の AXi(AXI4)も 2010 年リリースされた AMBA4.0

に含まれてる。 

 AXI プロトコルは主にメインデバイスとサブデバイスのデータエントリー方法を説明しました。

両者はハンドシェーキングシグナルを利用して連結する。サブデバイスがデータの受け入れ準備を出

来た時、READY 信号を出す。メインデバイスのデータが用意した時、VALID を維持する信号を出して、

データ有効を示している。VALID と READY 信号両方も有効の時だけ、データは伝送を始まる。この二

つも信号が有効のままでいたら、メインデバイスは次のデータを伝送する。両方のどちらが信号を取

り消したら、伝送は停止になる。AXI のプロトコルは図に表したように、T2 のときは、サブデバイス

の READY 信号が有効となり、同じく T3 のときはメインデバイスの VAlID 信号が有効となる。データ

伝送も始まる。 

 

 

 

 

 

 

 

AXI ハンドシェーキングシグシーケンス図 

 

  ZYNQ の中で、AXI-Lite、AXI4 と AXI-Stream 三つのバスをサポート出来る。表 5-1 から、この三

つの AXI インタフェースの特性が見られる。 

インタフェース

プロトコル 

特性 使用状況 
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AXI-Lite アドレス/シングルデータを転送 低速ペリフェラルやコントロール 

AXI4 アドレス/バーストデータを伝送 アドレスのロット伝送 

AXI-Stream データ伝送とバースト転送 データフローとメディア伝送 

 

  AXI4-Lite： 

  軽量級、構造簡単の特徴があって、小ロットデータや簡単なコントロールの状況に適切である。

ロット伝送はサポートしない。読み込んと書き込みをするとき、一回で文字ひとつしかリードライト

できない。主に一部の低速ペリフェラルを訪問とペリフェラルのコントロールに使う。 

  AXI4： 

  インタフェースは AXI-Lite とだいたい同じである。ただ一つの機能、ロット伝送を増えた。こ

の機能は連続でひとつのエリアのアドレスを一気にリードライトができる。つまり、データリードラ

イトの burst 機能。 

 

  以上の二つはメモリマッピングでコントロールしてる。すなわち、ARM はユーザーデファイン IP

をあるアドレスに編入して訪問する。リードライトの時もチップ内の RAM にしているように、プログ

ラミングも便利で、開発も難しくない。それを代わりに、資源を取り過ぎで、他のアドレス読み出し

コード、アドレス書き込みコード、データ読み出しコード、データ書き出しコード、リプライ書き込

みコードなどの信号線が需要である。 

  AXI4-Steam： 

  これはコンティニュアスストリームインタフェースの一種で、アドレスコードが必要ない(FIFO

に似ていて、ひたすらに読み出しあるいは書き込みすればいい)。このタイプの IP を対象にして、ARM

は以上のようにメモリマッピングでコントロールできない(FIFO はアドレスのコンセプトがない)、

コンバージョンデバイスが欠かせない。例えば、AXI-DMA モジュールでメモリマッピングからストリ

ームインタフェースに変換を実現する。AXI-Stream が適用の場合は多い：ビデオストリームの処理；

コミュニケーションプロトコルの変換；デジタル一眼レフカメラシグナルの処理；無線通信あどで使

います。本質ではニューメリカルフローにあって、構築されたデータ通路で、ソース(例えば ARM メ

モリ、DMA、無線レシーバーフロントエンドなど）からシンク(例えば HDMI モニター、高速 AD サウン

ド出力など)まで連続データストリームをつくった。こんなインタフェースは実時間信号処理に向い

ている。 

   

 AXI4 と AXI4-Lite インタフェースは五つの通路を含んでいる：    

   Read Address Channel 

   Write Address Channel    
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   Read Data Channel 

   Write Data Channel 

   Write Response Channl 

 

  中に、各通路は独立の AXI ハンドシェーキングプロトコル。下の図はそれぞれ読み出し 

と書き込みの模型を表している: 

 

 

 

 

 

 

 

AXI データ読み出し通路 

 

 

 

 

 

 

 

 

 

 

AXI データ書き込み通路 

 

   

ZYNQ チップ内部はハードウェアで AXI バスプロトコルを実現した。9つの物理インタフェースがあ

って、それぞれは AXI-GP0~AXI-GP3，AXI-HP0~AXI-HP3，AXI-ACP インタフェースである。 

 

AXI_ACP インタフェースは、ARM マルチコアアーキテクチャの一つのインタフェース、DMA のよう

なバッファが付けていない AXI ペリフェラルを管理する。PS ソケットは Slave インタフェースであ

る。 

AXI_HP インタフェースは、高性能/帯域幅の AXI3.0 標準のインタフェースである。全部は四つあ

って、PL モジュールをメインデバイスに連結する。主に PL が PS（DDR と On-Chip RAM）のメモリを

アクセスするときに使用する。 

AXI_GP インタフェースは、汎用な AXI インタフェースである。全部で四つあって、32 ビットのメ

インデバイスのインタフェースと 32 ビットサブデバイスのインタフェースが 2つずつある。 
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  ここで見られるのは、二つのAXI-GPだけはmaster Port、即ちメインフレームインタフェース。

残るの７つは Slave Port（サブフレームインタフェース）。メインフレームインタフェースはリー

ドライトを起こす権限があって、ARMは二つのAXI-GPメインフレームインタフェースっを利用して、

自発的に PL ロジックを訪問できる。PL をあるアドレスにマッピングしてると、PL のレジスタをリー

ドライトする時は自分のレジスタをリードライトしているようで。他のサブフレームインタフェース

は被動インタフェースで、PL からのリードライトを受ける。 

 また、この 9 つの AXI インタフェースの性能も違う。GP インタフェースは低性能インタフェー

ス、理論的な帯域幅は 600ＭB/ｓである。HP と ACP の方は 64 ビット高性能インタフェースで、理論

上で帯域幅は 1200MB/ｓ。ここで疑問を持っている人もいるだろう、なんで高性能インタフェースは

メインフレームインタフェースにしないのだろう？こうすれば、ARM で高速データ伝送を発起するの

も可能になる。答えは、高性能インタフェースは ARMCPU がデータ伝送をする必要がない。本当の運

ぶ屋は PL にある DMA コントローラーである。 

 PC ソケットに位置する ARM は AXI インタフェースをサポートえできるハードウェアがある。PL

はロジックを使って、相応の AXI プロトコルが実現する。Xininx は Vivada の開発環境に元々あった

IP を提供する。例えば、AXI-DMA、AXI-GPIO、AXI-Dataover、AXI-Steam はそれぞれのインタフェー

スを実現した後、使用の時は直接で Vivado の IP リストから添加すれば、相応の機能が実現できる。

下の図は Vivado にある DMA IP： 
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次はよく使われる AXI インタフェース IP の機能紹介： 

  AXI-DMA：PS メモリから PL 高速伝送通路 AXI-HP<---->AXI-Stream の変換を実現する。 

 AXI-FIFO-MM25：PS メモリから PL 汎用伝送通路 AXI-GP<---->AXI-Stream の変換を実現する。 

 AXI-Datamover：PS メモリから PL 高速伝送エクスプレス通路 AXI-HP<---->AXI-Stream の変換を

実現する。ただし、これは完全に PL にコントロールされて、PS はかんぜん被動的である。 

 AXI-VDMA：PS メモリから PL 高速伝送エクスプレス通路 AXI-HP<---->AXI-Stream の変換を実現

する。ただし、ビデオ動画、画像などの二次元データにだけに応用できる。 

  AXI-CDMA：この仕事はデータをメモリのある場所から別の場所へ移動することである。PL で完

成して、CPU が動き出す必要がない。 

 これらの IP をどう使うかについて、後の章で例を挙げ、説明する。時々ユーザー定義の IP を開

発して PS と通信する必要がある。この場合はウィーザー生成を利用し、それ相応の IP をる。ユーザ

ー定義の IP コアは AXI4-Lite、AXI4、AXI-Steam、PLB と FSL などのインタフェースを手に入れる。

PLB と FSL は ARM がサポートできないため、使わない。 

 以上のオフィシャル IP とウィーザー生成のユーザー定義 IP があれば、ユーザーは AXI シーケン

スに詳しく知る必要がある(問題が出る以外)。Xilinx は既に AXI シーケンスと関係あるディテール

をパケージングしたから、ユーザーは自分のロジックを実現できればいい。 

  厳しくいえば、AXI プロトコルは PTP のマスター・スレーブインタフェースプロトコルである。

いくつかのペリフェラルが互いにデータ交換を必要する時、AXI Interconnect モジュールに加入す

る需要がある、いわゆる相互関連マトリクス。これの作用は一つあるいは多数の AXI メインデバイス

と一つあるいは多数の AXI サブデバイスを連結する交換メカニズム(チェンジャーにある交換マトリ

ックスに似ている)。 

  この AXI Interconnect コアは最大限でメインデバイス 16 個、サブデバイス 16 個をサーポート

できる。これ以上のインタフェースを必要する場合、IP コアを増えればいい。 
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AXI interconnect の基本的連結モードは以下の 4種類ある： 

  N-to-1 Interconnect 

  to-N Interconnect 

  N-to-M Interconnect (Crossbar Mode)  

  N-to-M Interconnect (Shared Access Mod) 

 

 

多対一の場合 

 

 

 

 

 

 

 

 

 

 

 

                                       一対多の場合 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

多対多リードライトアドレスチャネル 
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多対多リードライトデータチャネル 

 

  ZYNQ 内部の AXI インタフェースデバイスは相互関連マトリクスの方法で繋がっている。データ

伝送の高効率を確保した同時に、連結の柔軟性も保証できる。Xilinx は Vivado でこの相互関連マト

リクスを実現する IP コア axi_interconnet を提供したので、必要の時はコールするだけでいい。 

 

 

AXI Interconnect IP 

 

2.2 ZYNQ チップの開発流れの紹介 

 

 ZYNQ は CPU と FGPA を統合したため、開発エンジニアは ARM の OS アプリケーションとデバイス

ドライバーだけてなく、FPGA 部分のハードウェアロジックをプログラミングする。開発中は LinuxOS

とシステムの構造を理解し、FPGA と ARM システムのハードウェプログラムプラットフォームを構築

するのも需要である。というわけで、ZYNQ の開発はソフトエンジニアがハードウェアエンジニアと

協同して、プログラミングと開発することである。即ち、ZYNQ 開発中が言っていた“HW-SW Co-design”

である。 

 ZYNQ システムのハードシステムとソフトシステムをプログラミング、開発するに必要な開発環
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境とデバッグツール：Xilinx Vivado 

 Vivado デザインスーツは FPGA 一部のプログラミングと開発、ピンとシーケンスの制限、コンパ

イルとシミュレーション、そして RTL からビットストリームのプログラミング流れを実現する。

Vivado は ISE デザインスーツを簡単にアップグレードしたものではなく、新たなデザインスーツで

ある。Vivado が ISE デザインスーツにある全ての重要ツールにとって代わった。例えば、Project 

Navigator、Xilinx Synthesis Technology、Implementation、CORE Generator、Constraint、Simulator、

Chipscope Analyzer、FPGA Editor などのデザインツールなどである。 

 Xililnx SDK（Software Development Kit）、SDK は Xililnx ソフトウェア開発スーツ（SDK）で

ある。VIvado ハードウェアシステムのもとで、システムは自動的に一部の重要なパラメータを配置

する。中にツールとベースパス、コンパイラーオプション、JTAG とフラッシュメモリ設定、デバッ

ガー連結とベアメタルボードサポートパケージ（BSP）が含まれている。サポートしている全ての

XilinxIP ハードコアにも、SDK はドライバープログラムを提供している。SDK は IP ハードコア（FPGA）

とプロセッサーソフトウェアの協同デバッグをサポートしている。高級 C又は C++言語を使って、AEM

と FGPA システムを開発とデバッグすることができる。こうしてハードウェアシステムが順序に働い

ているかをテストする。SDK ソフトも Vivado 内部にあるもので、別々でインストールの必要がない。 

  

ZYNQ に開発のハードウェア先で、ソフトウェアが後にする方法である。具体的な流れはこうなる： 

1） Vivado に新規プロジェクトを作成し、組込み型のソースファイルを一つ増加する。 

2） Vivado に PS と PL の一部基本的なペリフェラルを添加、配置しする。あるいは、ユーザー

定義のペリフェラルを配置する。 

3） Vivado にトトップファイル HDL を生成し、制約ファイルを加わる。そして、ビットストリ

ームファイル（*.bit）をコンパイルする。 

4） ハードウェアメッセージを SDK ソフト開発環境に書き出する。SDK 環境にデバッグソフト

を数個プログラミングして、これらのソフトでハードウェアとソフトウェアを検証したあと、ビッ

トストリームファイルと合わせて ZYNQ システムを単独にデバッグする。 

5） SDK に FSBL ファイルを生成する。 

6） VNware バーチャルマシンに u-boot.elf、bootloader のカーネルミラーイメージを生成す

る。 

7） SDK に FSBL ファイル、ビットストリームファイル system.bit と u-boot.elf ファイルで   

BOOT.bin ファイルを生成する。 

8） VMware に Ubuntu のカーネルミラーファイル Zimage と Ubuntu のルートファイルシステム

を生成する。他にも、FPGA のユーザー定義 IP を対象にドライバーをプログラミングする必要     

がある。 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  24  

9） BOOT、カーネル、デバイスツリー、ルートファイルシステを SD カードに書き込み、開発     

ボードの電源を入れたら、LinuxOS は SD カードから作動する。 

 

 以上は典型的な ZYNQ 開発ボード流れである。でも、ZYNQ も単純に ARM として使われる。こうす

れば、PL 側の資源が必要なくなり、伝統的な ARM 開発とそんなに区別を付けていない。ZYRQ も PL

部分だけを使うが、PL の配置はやはり PS で完成する。つまり、PL だけ必要とするファームを固体化

するには、伝統的な Flash の固体化方法で実現できない。 

 

2.3 ZYNQ の勉強はどんなスキルが需要 

ZYNQ の勉強は FPGA、MCU、ARM などの従来のツールよりレベルが高い、ZYNQ を使いこなすのもすぐ

達成できることではない。 

  

2.3.1 ソフト開発エンジニア 

 コンピューター基本知識 

 C、C++言語 

 コンピューターOS 

 tcl スクリプト 

 優れな英語を閲覧する基礎 

 

2.3.2 ロジック開発エンジニア 

 コンピューター基本知識 

 C 言語 

 デジタル回路基礎 

 Verilog、VHDL 言語 

 優れな英語を閲覧する基礎 
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第三章 Vivado 開発環境 

 

3.1 Vivado ソフトの紹介 

 

Vivadoは Xilinx会社が 2012年発表された新世代インテグレーションデザイン環境である。Vivado 

Design Suite User Guide の Getting Started（UG910）にこう書いていた： プログラマの効率を上

がる為、Vivado を出すことにした。このソフトは大幅に Xilinx の 28nｍ工芸のプログラマブルロジ

ックデバイスのデザイン、総合と実現効率を上げる事ができる。予想できるのは、FPGA が 28nｍ時代

に入り、ISE ツールは時代から外されているように見える。ハードウェアがレベルアップしたのに、

ソフトウェアがそのままだと、デザイン効率は必ず影響を受ける。 

 

3.2 Vivado ソフトバージョン 

   

   ZYNQ 開発ボードの全てのサンプルと教程は Vivado2017.4 の開発環境で完成するので、ソフト

バージョンで解明できない問題を避けるよう、勉強中はこちらと一致してください。使用する前に

Vivado 2017.4をインストールする必要ある。Xilinxのオフィシャルサイトからダウンロードできる。

オフィシャルサイトのダウンロードはアカウント登録が必要である。 

Vivado ソフトの Xilinx オフィシャルダウンロードサイト： 

https://japan.xilinx.com/support/download.html 

 

  Vivado の Linux バージョンと Windows バージョン、それとツーワンタイプのも提供している。

ここで使うのはツーワンタイプで、Windows と Linux 両方の開発を満足できる。Vivado を使用するに

は OS は 64 ビットになければならない。 

 

3.3 Vivado ソフトの Windows でのインストール 

 

1)   Vivado ソフトの圧缩ファイルダウンロードして、解凍する。xsetup.exe をクリックし、イン

ストール開始。 
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2)   バージョンアップを提示されたら、それを無視して、“continue”をクリックする。 

3)  “next”をクリックする、Vivado からのシステムに対する要求が見える。 

 

 

4)   “I Agree”をクリックして、各条項を受ける。 

 

 

 

5)   “Vivado HL Design Edition”を選択する 。 
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6)    デフォルト配置を使用して、“next”をクリックする。 

 

 

 

7)    ここではインストールパスを変えていない。インストールパスには日本語、スペース    

などの特殊文字を入れないようにする。コンピューターのユーザーネームも日本語、スペースを含ま

ないようにする。Vivado はハードディスクへの大きさ要求はおよそ 33G である。 
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8)  “Install”をクリックする。 

 

 

 

9)    インストールを待つ時間がながく、ウィルス防止ソフトを止めなかったら、インストール中

ブロックされ、インストール後使えない可能性がある。 
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10) ダウンローダーや開発ボードの JTAG 線を切る画面が出て、“確定”をクリックする。 

 

 

 

11)   インストール完了の画面が出る。 
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12)      License ファイルをインストールする。“Copy License”をクリックして、 

     “xilinx_ise_vivado.lic”というファイルを選択する。 
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13)   インストール成功のウィンドウが見える。 

 

 

 

14)   もう一度ダウンローダードライバーをインストールする必要があったら、Vivado のインス

トールパス “X:Xilinx\Vivado\2017.4\data\xicom\cable_drivers\nt64\digilent”に入って、

“install_digilent.exe”をクリックしてインストールする。その前に Vivado ソフトをしめる。

Vivado がダウンローダーを認識できない場合、 ファイアウォールとウィルス防止ソフトを閉めてく

ださい。同時にいくつかのバージョン違いの Vivado と ISE を開けることもいけない。 
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第四章 PL の“Hello World”LED テスト 

 

  Vivado をテストするプロジェクトは“led” 

 

ZTNQ にとって、PL（FPGA）開発はとても重要である。これも ZYNQ は他の ARM よりメリットある

ところで、いろんな ARM 側のペリフェラルをカスタマイズできる。カスタマイズする前に、まずは

LED サンプルで PL（FPGA）の開発流れと Vivado ソフトの基礎操作を慣れましょう。この開発流れは

ARM なしの FGPA チップと完全一致している。 

  本サンプルにするのは LED ライトをコントロールする実験である。秒ことで開発ボード上の LED

ライトをコントロールし、反転させる。ライトの点灯、消灯のコントロールを実現する。LED のコン

トロールができれば、ほかのペリフェラルも徐々に把握できる。 

  

4.1 LED ハードウェアの紹介 

 

1)  開発ボードの PL 部分は赤い LED ライトを４つ接続した。ライトは完全に PL でコントロール   

されている。 

 

 

 

2)  回路図による接続関係で LED と PL ピンの連携関係を確認できる。  

                   

 

 

対応のピンのインフォメーション 

 

3)  回路図に PS_MIO をはじめの IO は PS 側のもので、連携を必要ないし、連携できない。  
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4.2 Vivado プロジェクトを作成 

1） Vivado を起動する。Windows で Vivado のダブルクリックして起動する。 

 

2）Vivado の開発環境に“Create New Project”をクリックして、新規プロジェクトを作成する。 

 

   

3）画面に新規プロジェクトを作成するガイダンスが出て、“Next”をクリックする。 
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 4） ポップアップしたダイアログにプロジェクトのネームと保存する場所を入力する。ここ    

は led というプロジェクトネームを付ける。注意すべきことであるが、“Project location”に汉字

とスペースを入れないように、パスの名称も長くつけてはいけない。 

 

 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  35  

5）プロジェクトタイプで“RTL Project”を選択する。 

 

 

 

 6） ターゲット言語“Target language”で“Veriog”を選ぶ。“Veriog”を選択したが、VHDL

も使用できる。マルチリンガルプログラミングをサポートする。 
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7）“Next”をクリックして、ファイルを追加しない。 

 

8） “Default Part”オプションを開き、Filter の“Family”で“Zynq-7000”、パッケージ       

ングタイプ“Package”で“clg400”を選択する。AX7020 の方はそれぞれプルダウンリストで 

“xc7z020clg400-2”を選ぶ。“-2”はスビートレベルを表している。数字が大きいければ大きいほ

ど、性能はよくなる。スビート高いチップは下位互換性がある。 
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9） “Finish”をクリックして、“led”という名のプロジェクトは完成できる。 

 

 

 10） Vivado ソフトのインターフェイス 
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4.3 Verilog HDL ファイルを作成し、LED を点灯する 

１） Project Manager の Add Sources をクリックする（あるいはショットキーAlt+A を使う） 

 

 

 2）設計ソースを追加また作成の“Add or create design sources”を選択して、“Next”をク

リックする。 

 

 

3） ファイル作成“Create File”を選択する。 
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 ４） ファイル名“File name”を“led”にして、“OK”をクリックする。 

 

  

   5） “Finish”をクリックして、“led.v”の追加は完成する。 
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 6）ポップアップしたモジュール定義“Define Module”に、ファイル“led.v”のモジュール名       

を“Module name”に指定することができる。ここでは、“led”にする。一部のソケットも指定でき

るが、今は暫く指定しなく、“OK”をクリックする 

 

 

 ７） ポップアップしたダイアログボックスに“Yes”を選択する。
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 8） “led.v”をダブルクリックして、ファイルが開ける。編集する。 

 

 

 

9）“led.v”を編集する。ここで 32 ビットのレジスターtimer を定義した。0~49999999（１秒）

のループカウントに使い、49999999（１秒）に数えたら、レジスターtimer は 0 になり、四つの LED

を反転する。こうして、消した LED は点灯される。逆に、元々点灯している LED が消される。プロ

グラミングしたコードは下のように： 

`timescale 1ns/1ps  

module led( 

     input sys_clk, 

     output reg [3:0] led 

     ); 
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 reg[31:0] timer_cnt; 

 always@(posedge sys_clk) 

 begin 

     if(timer_cnt >= 32'd49_999_999) 

     begin 

        led <= ~led; 

        timer_cnt <= 32'd0; 

     end 

     else 

     begin 

         led <= led; 

         timer_cnt <= timer_cnt + 32'd1; 

     end 

     end endmodule 

 

10）コードを編集したあと、メニュー“File->Save All Files”をクリックする。 

 

 

4.4 ピン制約を追加 

 

 Vivada が使っている制約ファイルのフォーマットは xdc ファイルである。xdc ファイルは主にピ

ンの制約、タイマーの制約、それとグループの約束である。ここでは led.v に入出力ポートを FPGA

の実在なピンに分配することである。 

 1） “Open Elaborated Design”をクリックする 

 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  43  

 

 

 2） ポップアップしたウィンドウに“OK”ボタンを押す 

 

 

 

 3） メニューで“Window -> I/O Ports”を選択する日
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 4） I/O Ports がポップアップされ、そこでピンの分配状況が見える 

 

 

 

 5） LED とタイマーにピン、レベル標準を分配する。完成したら、保存アイコンをクリックする。 

 

 

 6)  ウインドウがポップアップされ、制約の保存を要請する。ファイル名は“led”を書いて、フ

ァイルタイプはデフォルトの“XDC”。“OK”をクリックする。 
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 7） 先程生成したファイル“led.xdc”を開いて、TCL スクリプトが見える。これらの構文を分か

れば、自分で led.xdc を編集することでピンを制約できる。 

 

 

 

 次は最も基礎的な XDC コーディングのグラマーを紹介する。普通な IO ポートはピン番号と電圧を

制約すればいい。 

 ピンの制約は下のように： 

  set_property  PACKAGE_PIN  "ピン番号"  [get_ports “ポートネーム”] 

  レベル信号の制約は下のように： 

  set_property    IOSTANDARD   "レベル標準"  [get_ports “ポートネーム”] 
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  ここで注意するのは文字のフォントである。ポートネームはアレイだとしたら、｛｝で括る。ポートネームは

必ずソースコードの名前と一致して、キーワードと同じくしてはならない。 

  レベル標準で、“LVCMOS33”のあとの数字はFPGAのBANK電圧である。LEDがいるBANK電圧は3.3Vから、レベ

ル標準は“LVCMOS”である。Vivado のデフォルトコマンドは全てのIOに正確なレベル標準とピン番号を分配する

ことである。 

 

4.5 シーケンス制約を追加 

  FPGA のデザインはピンの分配以外、もう一つ重要な制約ある。それはシーケンス制約である。こ

こはガイダンス方法でシーケンス制約を行う。 

 1） “Run Synthesis”をクリックして、統合を開始する。 

 

 

  2） ダイアログがポップアップされて、“Ok”をクリックする 
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3） 統合を完成したら、“Cancel”をクリックする 

 

 

 

  4） “Constraints Wizard”をクリックする 
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5） ポップアップされたウィンドウで“Next”をクリックする 
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 6）  シーケンス制約ガイダンスを使ってデザイン中のタイマーを分析する。ここは“sys_clk”   

頻度を 50Mhz にして、“Skip to Finish”をクリックしシーケンス制約ガイダンスは終了。 

 

 

  7） ダイアログがポップアップされて、“Ok”をクリックする 

 

 

 

  8） “Finish”をクリックする
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10） この時、led.xdc ファイルがアップデートされる。“Reload”をクリックして、改めて    

ファイルをアップロードする 

 

 

4.6 BIT ファイルを生成する  

 

 1） プログラミング中は総合、レイアウト、BIT ファイルを生成することなどに細分化できる。

ここでは、直接“Generate Bitstream”をクリックして、BIT ファイルを生成する。 
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 2） ポップアップされたダイアログに任務の数を選べる。ここと CPU コア数に関係してい    

る。一般的には、数字が大きいければ大きいほど、プログラミングは早くなる。“OK”をクリックす

る。
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 3） コンパイルを開始して、右上のとこは状況を反映するメッセージ欄が見える。コンパイル

中はウィルス防止ソフトにブロックされる可能性があって、コンパイルができない、又は長時間にコ

ンパイルが成功できないことになる。 

 

 

 4） コンパイルはノーミスで完成したらダイアログがポップアップされて、引き続きの操作    

を選ぶ。“Open Hardware Maneger”を選択し、“OK”をクリックする。もちろん“Cancel” も選べ

る。左のガイド欄で“Open Hardware Manger”をすればいい。 

 

 

4.7 ダウンロードとデバッグ 

 1） 開発ボードの JTAG インタフェースを接続して、電源を入れる。 

 2） “HARDWARE  MANAGER”インタフェースで、“Auto Connect”をクリックして、自動的に設

備と接続する。 
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 3） JTAG が ARM と FGPA のカーネルをスキャンする（図では xc7z015 が、AX7020 開発ボードの

場合は xc7z020_1 である）。また一つの XADC があって、システムの電圧と温度を検測できる。 

 

  

4） xc7z015_1（xc7z020_1）を選択して、右クリックすると“Program Device”のオプションが

出る。 
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 5) ポップアップされたウィンドウで、“Program”をクリックする。 

 

 

 6） ダウンロードを待つ。 

 

7） ダウンロード完成したあと、四つの LED は秒ことで変化し始める。ここまで、Vivado の簡単           

な流れ体験が終わる。後の章はこんなことを紹介する：プログラムを Flash に書き込む場合、PS シ

ステムの協力が必要になる。PL のみのプロジェクトは Flash に書き込めない。
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第五章 HDMI 輸出実験 

  実験用 Vivado プロジェクトは“hdmi_output_test”。 

 前の章で、led の点滅実験を紹介した。これはただ Vivado の基本の開発流れを了解する

ため。本章の実験は LED 点滅事件よりすこし複雑で、内容は HDMI でのカラーバーの表示であ

る。これも今後表示、ビデオ処理の基礎である。 

 

5.1 ハードウェアの紹介 

開発ボードは HDMI コーディングチップを使っていない。その代わりに、FPG の 3.3V 差分 IO を 直接

HDMI コネクタに接続する。 

FPGA が 24 ビット RGB コードの出力で TMDS 差分信号を実現する。  

 

 

5.2 Vivado プロジェクトを作成する 

1) “hdmi_output_test”というプロジェクトを作成する。 

5.2.1 HDMI コンパイラーIP コアを追加する 

2) repo フォルダ（このフォルダは提供したサンプルプロジェクトにある）をプロジェク

トメニューにコピーする。フォルターに HDMI コンパイラーの IP がある 
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3) “IP Catalog”をクリックして、標準設置でこれらの IP はすべて Xilinx が提供

されている。いまは第三者の IP、あるいは自分で作った IP を追加する。 

 

 

4) 右ボタンを押し、“Add Repository...”クリックする。
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5) パスは先コピーした repo フォルターにする。 

 

 

 

6) IP を追加して、成功に追加した IP の数を提示する。  
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7) “RGB to DVI Video Encoder(Source)”を見つけ、ダブルクリックする。 

 

 

 

8) 下のウィンドウがポップアップされ、コンポーネント名“Component Name”を変更せず、

他のパラメータもそのまま。“OK”をクリックする。 

 

 

 

9） “Generate Output Products”のウィンドウが出る。中にも“Number of jobs”はスレ

ット数で、数値が高ければスビートも早い。 
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10)   rgb2dvi_0 というファイルが見える。 
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5.2.2 ピクセルクロックの PLL モジュールを追加する 

 

 HDMI コンパイラーをドライブされる為、ピクセルクロックと 5倍のピクセルクロックが需要

になる。5倍の方は 10:1 シリアル化に使用される。 

 

11）“IP Catlog”ウィンドウでキーワード“clock”をサーチして、“Clocking Wizard”をダブ 

ルクリックする。 

 

 

 

12）今回はコンポーネントに名前を付ける。这次给元件起个名字，“Component Name”

欄で“video_clock”、“clk_in1”欄で 50 を入力する。ここの 50Mhz は開発ボード PL 側のク

リスタル頻度と一致している。 
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13) アウトプットクロック“clk_out1”はビデオピクセルクロックに用いられる。こ

こで 74.25 を入力する。これは 1280x720@60 解析度のピクセルクロックである。各解析度のピクセ

ルクロックが違っていて、ビデオ標準にかなり詳しい人だけが、各ビデオ解析度のピクセルクロックを知ってい

る。“clk_out2”はコンパイラーのシリアルかに使われている。ピクセルの5倍は371.25

を入力する。次は“OK”をクリックして、IP を生成する。 
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5.2.3 カラーバー発生モジュールを追加する 

 

14) カラーバー発生モジュールは一列の Verilog コードで、ビデオシーケンスと用

于产生视频时序和水平方向の八つのカラーバーを生成するに使われている。FPGA は本開

発の 

  ポイントではないので、コードのことを詳しく説明しない。提供したサンプルに

あるコートをコピーできる。 日
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5.2.4 トップモジュールを追加する 

 

15) トップモジュールはカラーバー発生モジュール、HDMI コーディングモジュールと

ピクセルクロックをインスタンス化にした。コードはサンプルにあるプロジェクトを参

観する。 
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5.3 XDC 制約ファイルを追加する 

 下の xdc 制約ファイルをプロジェクトに追加する、ファイルにクロックと HDMI に関するピ

ンも加わっている。 
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5.4 ダウンロードとデバッグ 

 プロジェクトを保存し bit ファイルにコンバインする、HDMI インタフェースを HDMI モ

ニターに接続する。注意するのは、ここで 1280x720@60Hz を使うので、自分のモニターはこ

の解析度をサーポートできることを確保してください。 

 

 

 

ダウンロード後モニターは下の画面を表示する。

set_property PACKAGE_PIN U18 [get_ports {sys_clk}] 
set_property IOSTANDARD LVCMOS33 [get_ports {sys_clk}] 

create_clock -period 20.000 -waveform {0.000 10.000} [get_ports 
sys_clk] set_property IOSTANDARD TMDS_33 [get_ports TMDS_clk_n] 
set_property PACKAGE_PIN N18 [get_ports TMDS_clk_p] 

set_property IOSTANDARD TMDS_33 [get_ports TMDS_clk_p] 
set_property IOSTANDARD TMDS_33 [get_ports {TMDS_data_n[0]}] 
set_property PACKAGE_PIN V20 [get_ports {TMDS_data_p[0]}] 
set_property IOSTANDARD TMDS_33 [get_ports {TMDS_data_p[0]}] 
set_property IOSTANDARD TMDS_33 [get_ports {TMDS_data_n[1]}] 
set_property PACKAGE_PIN T20 [get_ports {TMDS_data_p[1]}] 
set_property IOSTANDARD TMDS_33 [get_ports {TMDS_data_p[1]}] 
set_property IOSTANDARD TMDS_33 [get_ports {TMDS_data_n[2]}] 
set_property PACKAGE_PIN N20 [get_ports {TMDS_data_p[2]}] 
set_property IOSTANDARD TMDS_33 [get_ports {TMDS_data_p[2]}] 
set_property PACKAGE_PIN V16 [get_ports hdmi_oen]  
set_property IOSTANDARD LVCMOS33 [get_ports hdmi_oen] 
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5.5 実験のまとめ 

 

 本実験は初歩にビデオ表示を接触した。ビデオ知識関わっているが、zynq を学ぶキー

ポイントではないので、詳しく紹介していない。しかし、zynq はビデオ紹介領域でよく使

われているから、勉強者は良き基礎知識が必要である。実験中は PL だけ使用して HDMI チッ

プをドライブして、第三者がカスタマイズする IP の使い方を初歩に学んだ。引き続きはカ

スタマイズ IP の作り方を学ぶ。 
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第六章 ARM を体験 

    

実験用 Vivado プロジェクトは“ps_hello”。 

 

 前の実験は PL 側で行わている。はっきり見えるのは、普通の FGPA 開発流れと何の区別

がないことである。ZYNQ の優勢は FPGA と ARM を合理的に結ぶことなので、開発エンジニア

ににより高く要求している。本章から、ARM いわゆる PS の利用を始める。今回は簡単なシリ

アルプリントで Vivado SDK と PS の特性を体験する。 

 

6.1 ハードウェアの紹介 

 原理図から見えるのは、ZYNQ チップは PL と PS に分けられる。PS 側の IO 分配は相対的

に固定で、任意で分配するにはいけない。Vivado ソフトでピンの配りも必要ない。本実験で

は PS しか使っていないが、Vivado プロジェクトの作成は需要で、PS ピンの配置に用いられ

る。 

 

6.2 Vivado プロジェクトを作成 

1) “ps_hello”というプロジェクトを作成する。 

2)   “Create Block Design”をクリックし、Block デザインを作成する。 
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3) ここで“Design name”は変更しないで、デフォルトの“design_1”にする。変更の需要

があったら、名前はできるだけ短くする。そうしなければ、Windows でのコンパイルは問題が

出る。 

 

 

 

4) “Add IP”のショートアイコンをクリックする。 

 

 

 

5) “zynq”を検索する。検索したリストで“ZYNQ7 Processing System”をダブルクリ

ックする。
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6)  Block 図の“processing_system7_0”をダブルクリックして，関係するパラメータを追加

する。 

 

 

 

7) “PS-PL Configuration”で全ての項目を表にする。 
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8) “M AXI GP0 interface”インタフェースを取り消す。このインタフェースは PL

側の AXI インタフェースペリフェラルを拡張できる。この原因で、PL は PS とデータ交

換をするなら、AXI バスインターフェスプロトコルに沿いで交換を行う。Xilinx は大量

な AXI インタフェースの IP コアを提供した。 
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6.2.1 UART 配置 

9) 原理図から、シリアルは PS の MIO48-MIO49 上に接続していることが見つける。

“Peripheral I/O Pins”オプションで UART1（MIO48 MIO49）を開く。Bank 0 電圧は“LVCMOS 

3.3V”、Bank 1 电压 は“LVCOMS 1.8 V”を選択する。本実験はシリアル機能は一つだけ使

っている。ここでは他の設備は使用しない。 

 

 

 

6.2.2 クロック配置 

 

10) “Clock Configuration”のオプション欄で、PS クロックのインプット頻度を配置

できる。デフォルト値はボートと同じく 33.333333 で、変更する必要ない。CPU 頻度のデ

フォルト値は 666.666666Mhz、ここも変更しない。同時に PS は PL 側にクロック四重も提

供でき、頻度は配置できる。ここは必要ないから、デフォルト値にすればいい。 
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6.2.3 DDR3 配置 

11) “DDR Configuration”オプションで PS側の ddr パラメータを配置できる。
AX7010 は DDR3 型番を“MT41J128M16 HA-125”に、 AX7020 は DDR3  型番を“MT41J256M16 
RE-125”にする。ここの ddr3  型番はボートでの ddr3  型番ではなく、パラメータが
一番近いタイプである。“Effective DRAM Bus Width”で“32 Bit”を選択する。 
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AX7010 DDR3 配置 

 

AX7020 ddr3 选择 
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12) “Run Block Automation”をクリックして，vivado ソフトは自動的に一部のポ

ート書き出す仕事を完成する。 

 

 

13)  “OK”をクリックする。 

 

 

 

14) “OK”をクリックしたあとは、PS 側からエクスポートたピンが見える。DDR と

FIXED_IO も含んでいる。“Ctrl + s”を押してデザインを保存する。 
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15)   Block デザインを選択する。右ボタンを押し、“Create HDL Wrapper...”を選ぶ。Verilog

またはVHDL ファイルを作成する。 

 

 

 

16)  デフォルトオプションのままで、“OK”をクリックするため。 
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17)   デザインを開け、PS は普通な IP で使われているのが見える。 

 

 

 

18)   block デザインを選択する。右ボタンを押して、“Generate Output Products”を選 

    ぶ。 

 

 

 

19)  “Generate”をクリックする。 
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20)   メニュー欄で“File -> Export -> Export Hardware...”の順番でハードウェア 

   インフォメーションを書き出す。ここに PS の配置も含んでいる。 
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21)   ポップアップしたダイアログに“OK”をクリックする。実験はただ PS のシリアルを  

   使って、PL が参加していないから、ここでは“Include bitstream”を作動させてない。 
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6.3 SDK デバッグ 

1)  Vivado メニューで“File -> Launch SDK”をクリックして、 SDK を起動する。 
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2)  SDK 起動して、ファイルふが見える。“system.hdf”というファイルがあって、Vivado ハ

ードウェアデザインのメッセージが含んでいる。ソフト開発にも使用できて、PS 側ペリ

フェラルのレジスタリストも見える。 

 

 

 

3) めメニューで“New -> Application Project”をクリックして、 APP プロジェク

トを作成する。
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4) “Project name”は“hello”書き込んで、他のはデフォルト値にする。“Next”を    ク

リックする。 
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5) モジュールは“Hello World”を選択、“Finish”をクリックする。 
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6) SDK は“hello”という目次ぐを作成した。もう一つの目次ぐは“hello_bsp”である。

“hello_bsp”の目次ぐで使えるもインフォメーション大量である。中の“BSP 

Documentation”に一部の PS ペリフェラルの API 説明が入っている。
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7) “system.mss”をダブルクリックする。一部のPSペリフェラルはサンプルも提供している。

これは対応のペリフェラルを学ぶ大切な資料である。 
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8)   JTAG ケープルを開発ボードに接続して、UART 的 USB ケープルを PC に接続する。 

 

9)  PuTTY ソフトをシリアルターミナルデバッグツールにする。PuTTY は無料ダウンロードの   

ソフトである。 
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10)  Serial，Serial lineをCOM3欄にデータを入れる。Speed欄に115200を書き込む。

COM3 シリアル番号はデバイスマネージャに表示したように写す。“Open”をクリッ

クする。 

 

 

  

   11)  電気を入れる前に、開発ボードの起動モードを JTAG モードに設置する。 
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12) 開発ボードに電気を入れて、プログラムの作動に準備をする。出荷の時、開発ボードは既に

プログラムがつけられている。ここで、作動モードを JTGA モードに選び、改めて電気いれをする。

“hello”を選択し、右ボタンを押せば、オプションがたくさん見える。本実験に使うのは“Run as”

で、プログラムを起動するとこと。“Run as”にもオプションたくさんあって、一番目“Launch on 

Hardware(System Debuger)”を選択する。システムでデバッグをして、直接プログラムを作動する。 
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13) この時は PuTTY ソフトを観察する。アウトプットが表示されるかも、アウトプットがないかも

知らない。 

 
 

14)   システムのデバッグを保証するため、配置一つ追加必要がある。右ボタンを押し、     

“Run As -> Run Configuration...”の順番で操作する。 
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15)  “Reset entire system”を選択して、システムをリセットする。システムにまだ PL

デザインがあったら、“Program FPGA”を選択してから，再び“Run”をクリックする。 

 

16)   “OK”をクリックし，再起動を確定する。 

 

 

 

17)   今回見知りの“Hello World”が画面に表示された。 日
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テ
ク
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18)   “Run As”以外、“Debug As”もう使用できる。こうして、ブレイクポイントを設置でき、    

シングルステップで作動できる。 

 

 

 

19)   Debug モードに入る。 
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20)   IDE を開発は他の C言語と同じ、ステップバイステップで作動するやブレイクポイントを設

置できる。 
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21)   右上で IDE モードが変更できる。  

 

 

 

6.4 実験のまとめ 

 

 本実験は簡単な Hello World で SDKの使い方を説明した。SDKは強い機能があって、一つ一つ

で紹介できないが、使用の繰り返しでだんだん把握できると思う。 

 

6.5 よくある問題 

 

6.5.1 vivado に通じて SDK を起動後、ウィンドウがポップアップされていない 

 

   1)  Vivado ソフトをインストールする時はかならず SDK もインストールする。 

2)   SDK を起動する前に sdk 目次ぐがあったら、SDK が起動できないことになる。この目次ぐ 

   を削除してから試す。 日
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第七章 PS で PL の LED を点灯する 

実験用 Vivado プロジェクトは“ps_axi_led”。 

 

zynq の使用に一番大きい疑問はどうすれば PS と PL を結んで使用できることである。一

般的に、ほかの SOC チップに GPIO がある。本実験は AXI GPIO の IP コアを一つ使って、PS

側を AXI バスで PL 側の LED ライトをコントロールする時は。実験は簡単が、PL と PS と結

びつく方法を示す。 

 

7.1 Vivado プロジェクトを作成する 

1） “ps_axi_led”Vivado という名のプロジェクトを作成して、PS が AXI パスで LED ライト      

をコントロールすることを表示する。 

2)   Block デザインを作成する。 

 

 

 

3)   ZYNQ プロセッサーを追加する。 
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7.1.1 UART 配置 

1) Bank1 レベル標準を LVCMOS 1.8V に配置する。Bank1 のレベル標準を配置しないと、

シリアルポートが受け取れないかもしれない。シリアルポートを作動させ、 MIO48 MIO49

を使う。 

 

 

 

7.1.2 DDR3 配置 

 

1)   AX7010 は DDR3 の型番を“MT41J128M16 HA-125”に、 AX7020 は DDR3 の型番を 

“MT41J256M16 RE-125”に配置する。ここのddr3タイプはボードでの ddr3タイプではな く、

パラメータが一番近いタイプである。 
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AX7010 DDR3 配置 
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AX7020 ddr3 选择 

 

2)  AXI GPIO の IP コアを一つ追加する。 

 

 

 

7.1.3 AXI GPIO を追加する 

 

 

1) 先程追加した“axi_gpio_0”の配置するパラメータをダブルクリックする。 
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2)   “All Outputs”を選択する。 LEDをコントロールしたから、アウトプットするだけていい。

“GPIO Width”欄で 4を入れて、4つの LED をコントロールする。 “OK”をクリックする。 

 

 
 

3)   “Run Connection Automation”をクリックして、一部の自動連線ができる。 
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4)   自動的に接続するポートを選択する。ここはどこ全部選んで、“OK”をクリックする。 

 

 

 

5)   “Run Block Automation”をクリックする。 

 

 

6)  “OK”をクリックする日
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7)   “Optimize Routing”をクリックして、レイアウトを最適化できる。 

 

 

 

8)   GPIO ポートの名前を変更する。
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9)    ネームをleds に変更する。 

 

 

 

10)    HDL ファイルを作成する。 
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11)  “OK”クリックする。 

 

 

 

12)   生成した Verilog ファイルに、“leds_tri_o”のアウトプットポートが見える。これらの 

   ポートにピンを配る。 
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7.2 XDC ファイルで PL ピンを制約する 

1) 新規 xdc 制約ファイルを作成する。 

 

 

2) ファイルネームは led にする。 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  106  

 

 

 

3) led.xdc に内容を追加する。ポートネームはからなずトップファイルポートと一致する。 

 

 

 

7.3 SDK プログラムをコンパイルする 

1) bit ファイルを生成する。 

 

 

 

2) ハードウェアを書き出す。 

set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[3]}] set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[2]}] set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[1]}] set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[0]}] set_property PACKAGE_PIN M14 [get_ports 
{leds_tri_o[0]}] set_property PACKAGE_PIN M15 [get_ports 
{leds_tri_o[1]}] set_property PACKAGE_PIN K16 [get_ports 
{leds_tri_o[2]}] set_property PACKAGE_PIN J16 [get_ports 
{leds_tri_o[3]}] 
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3)  PL を使用するから、“Include bitstream”を選択し、“OK”をクリックする。 

 

 

 

4) SDK を起動する。 
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5) “axi_led”的という APP を作成して、プロジェクトテンプレートは Hello World に

選ぶ。 

 

 

 

6) 慣れていない AXI GPIO をどうコントロールする？SDK 内部のサンプルを試しておこう。 

7) “system.mss”をダブルクリック、“axi_gpio_0”を見つかる。“Documentation”をクリ
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ックして、それに関するファイルを見る。 ここは見本を出せず、直接“Import Examples”をクリックす

る。 

 

 
 

8) ポップアップされたダイアログはいくつかのサンプルがあり、ネームからどんな内容が  

見当がつける。ここは一番目の“xgpio_example”を選ぶ。 

 

 

 

9) サンプルは簡単で、少ないコードで、AXI GPIO の操作を完成した。 
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 中に GPIO に関する API 関数を使用している。ファイルで詳しいことを了解できる。こ

の関数を選んで F3 を押せば具体的な定義も見える。これだけのインフォメーションがあっ

て、まだ AXI GPIO の使用を理解できないなら、C言語基礎を補充すべきである。 

 

7.4 ダウンロード及びデバッグ 

1) SDK は数多くのサンプルを提供できるが、一部のサンプルは自分で変更するものである、こ

の簡単な LED サンプルは変更せず、作動してみよう。予想の効果とかなり距離があって、エラーの提

示も出た。 
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2) 前の内容はもう“Run As”がシステムのリセットに効果抜群ということを説明した。 PL のデ

ザインは“Program FPGA”が必要である。PL が何度も更新されたら、改めてハードウェアを書き出す

のが忘れないよう。下の画像のように配置して、再起動する。開発ボードの LED1 が素早くブリンクし

ている。 

 

 

 

3) コードを変更して、２つの LED 両方もブリンクする。 
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7.5 実験のまとめ 

 

実験で PS は AXI パスに通じて PL をコントロールすることを了解した。しかし、ZYNQ の優位を

表現されていない見たい。その原因は、LED ライトをコントロールすることなら、ARM も FGPA も

楽に完成できる。でも LED をシリアルポートにしたらどうなるか？100 重シリアルポート通信や

8重イーサネットなどのアプリを制御するようなことは、どこの SDC も完成できないと思う。こ

れは ZYNQ しかできないこと。これも ZYNQ と普通の SDC との違いである。 
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第八章 PS タイマーインタラプト実験 

実験用 Vivado プロジェクトは“ps_timer”。 

 

たくさんの SDC は内部にタイマーがある。ZYNQ の PS にもある。ZYNQ にはどんなペリフェラル

があるか、これらのペリフェラルはどんな特性あるか？それはエンジニアが了解すべくことなの

で、よく xilinx のマニュアル UG585 を読むのがお勧めです。 

 

8.1 Vivado プロジェクトを作成する 

 

   1)  数個 Vivado プロジェクトを作成する。中にも同じ仕事は大量にあって、最優な解 

     決法はプロジェクトをコピーして、変更する。“ps_hello”を開く。 

     2)  メニューで“File -> Save Project As... をクリックする。 

 

 

 3）ポップアップされたダイアログに新規プロジェクト名“ps_timer”を入れる。サ

ブディレクトリの作成を選択する。PSのタイマーはピンでアウトプットをするとき必要

がないので、ピンを配置しない。 
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8.2 SDK をプログラミング 

1)  SDK を起動する。前のサンプルと違っていて、ここはハードウェアプラットフォームの 

  ファイルが一つ多くなった。 

 

 

 

2) 他人の SDK プロジェクトを使うときも似たようなことがあって、全てを削除する。 

 

 

3) ファイルも削除する。 
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4) もう一度 Vivado に SDK を起動した、新しいハードウェアプラットフォームメッセージが 

  見えてくる。 

 

 

 

5) 新規プロジェクトを作成する。“ps_timer_test”という名で、テンプレートは 

  Hello Worldにする。 

 

 

 

6) コーディングのときが来て、どこから始めるかは知らないでしょう。タイマーの使
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い方も、インタラプトする方法も見当をつけない。いつもの通り、例をみよう。 

 

 

7)  タイマーインタラプトの例一つあった。この例はインタラプトの例ってことはどう

確認するか？“intr”から推測した。ということで、基礎がとても重要で、把握できないと、

サンプルも探せない。 

 

 

 

次はコードを読むと変更することである。すぐにコードを全部理解できないのも当然である。

これから使用中で何度も練習するしかない。 

 

8) 本実験はタイマーが一秒ことにインタラプトして、メッセージをプリントアウト

する。30 秒後おわり。まずカウンターを変更するから。最大値は CPU 頻度の半分にし

て、つまりカウンターのクロック頻度値になる。こうして、１秒ことにインタラプト

ことになる。 
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9) カウンターの回数は 3から 30 に変更する。 

 

 

 

10)   プリントのインフォメーションを追加する。 
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8.3 ダウンロードとデバッグ 

1) PuTTY シリアルポートターミナルを開く。 

2) デバッグプログラムのダンロード前の章でもう説明した。 

 

 

3) 予想通り、シリアルポートは秒ことにメッセージをアウトプットする。日
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8.4 実験纏め 

 

実験中 SDK のサンプルうを少し変更するしてタイマーとインタラプトの応用をかんせいし

た。操作簡単に見えるが、豊かな知識が含んている。タイマー、インタラプトの原理詳しく

知る必要がる。これらの基本知識は ZYNQ を把握する必要条件である。 
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第九章 PL キーインタラプト 

実験用 Vivado プロジェクトは“ps_axi_key”。 

 

前の章にしたタイマーインタラプト実験は PS 内部のインタラプトで、本実験のインタラプトは

PS から出てくる。PS は PL からのインタラプト信号は 16 も受けられて、立ち上がりエッジとハ

イレベルを通じてトグルする。本実験はボタンインタラプトを使用してLEDをコントロールする。 

 

 

9.1 Vivado プロジェクトを作成する 

 

1) 本実験使用している Vivado プロジェクトは“ps_axi_led”だけを使う。この

プロジェクトにボタンインプット用の AXI GPIO を追加すればいい。メニューの

“File -> Save Project As...”をクリックする。 

 

 

2) 新規プロジェクトは“ps_axi_key”にする。

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  121  

 

 

 

3） AXI GPIO を一つ追加する。 

 

 

 

 

4)  GPIO パラメータを配置して、全部をインプットにする。幅は 1に設置し、インタラプト 

   が発生できるように。 
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5) オートコネクションを使う。 

 

 

 

6) ポートネームは keysに変更する。
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7) ZYNQ プロセッサーのインタラプトを配置して、IRQ_F2P を選択する。 

 

 

8) ip2intc_irpt を IRQ_F2Q に連結する。
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9) xdc 制約ファイルを変更する。 

 

 

 

 

10)   デザインを保存して、 bit ファイルを生成する。 

 

9.2 ダンロードとデバッグ 

 

1) SDK を起動する，他のプロジェクトからコピーしたもので、SDK に必要ないファイ

ルが入っている。それを全部削除してから、再起動する。 

set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[3]}] set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[2]}] set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[1]}] set_property IOSTANDARD LVCMOS33 [get_ports 
{leds_tri_o[0]}] set_property PACKAGE_PIN M14 [get_ports 
{leds_tri_o[0]}] set_property PACKAGE_PIN M15 [get_ports 
{leds_tri_o[1]}] set_property PACKAGE_PIN K16 [get_ports 
{leds_tri_o[2]}] set_property PACKAGE_PIN J16 [get_ports 
{leds_tri_o[3]}] 
 

set_property IOSTANDARD LVCMOS33 [get_ports 
{keys_tri_i[0]}] set_property PACKAGE_PIN N15 [get_ports 
{keys_tri_i[0]}] 
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2) 新規 APP を作成。 

 

 

 

3) Project name を“key_test”に設置する。 
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4) 前の言った通り、SDK プログラムに慣れていない状況で、できるだけ SDK 内部のサンプ

ルを使って変更する。  
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5) “xgpio_intr_tapp_example”を選択する。 

 

 

 

6) サンプルをインポートしたあと、未知なエラーが出て、一部のコードを変更する必要が 

  ある。  

 

 

 

7) 下の図に従って GPIO とインタラプト番号のマクロ定義をへんこうする。 
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 8) テストの遅延時間を変更して、ボタンを押す余裕があるように。 

 

 

  

 9) シリアルターミナルを開き、プログラムを起動する。 
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10) 長時間ボタンを押さないと、シリアルポールは“No button pressed.”を表示する。“PL KEY1”

を押すと、“Successfully ran Gpio Interrupt Tapp Example”が表示される。 
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9.3 実験まとめ 

 

 PL 側は PSにインタラプト信号を伝送でき、PLと PSのデータ交換 PLの効率を高めた。大数、

低遅延の APP にインタラプト処理が必要である。  
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第十章 イーサネット実験（LWIP） 

実験用 Vivado プロジェクトは“net_test”。 

 

 開発ボードに１重ギガイーサネットがあって、RGMII インタフェースで接続する。本実

験は SDK 内部の LWIP テンプレートでギガイーサネット TCP 通信する方法を説明する。LWIP

は軽量級プロトコルが、一度も使用したことがないなら使うときは少し難しい。こちらの意見

はLWIPに関する知識を了解すべき。 

 

10.1 Vivado プロジェクトを作成 

 

1) 新規 vivado プロジェクト“net_test”を作成して、ZYNQ を追加する。前の教程

にシリアルポールを配置する。詳しいパラメータはサンプル内部のプロジェクトを 

参考できる。 

 

10.1.1 PS 側のイーサネット配置 

 

1) “Enet0”（MIO16-MIO27）と“MDIO”（MIO52-MIO53）を起動させる。 

 

 

 

2) Enet0 のレベル標準を STL 1.8V にし、Speed  を fast に変更する。これらのパラメータ

は非常に重要なので、変更しないと、ネットが繋がらない。 
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3) HDL ファイルを作成する。 
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2) bit ファイルを生成する。そして、ハードウェアインフォメーションをエクス 

      ポートする。SDK を起動する。 

 

 

10.2 SDK プログラム 

10.2.1 LWIP テンプレートに基づく APP を作成 

 
 

10.3 ダウンロードとデバッグ 

 

 テスト中環境は dhcp をサポートするルーターが必要である。開発ボードはルーターと接続す

ると自動に IP アドレスを獲得できる。実験中メインフレームと開発ボードは同じネットワークに

いて、お互いに通信できる。 

 

10.3.1 イーサネットテスト 

 

1)シリアルポールと接続して、シリアルでバッグターミナルを開く。PS 側のイーサネットケーブ

ルをルーターに接続して、SDK を起動する。 
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2) シリアルはインフォメーションをプリントアウトして、自動的に   

 “192.168.1.68”というアドレスを獲得した。接続速度は1000Mbps で、tcp ポー 

 トは 7である。 
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3) telnet を使って接続する。 

 

 

 

4) 文字一つを書き込む時、開発ボードは同じ文字を表示する。 
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10.4 実験のまとめ 

 実験をつうじて、SD プログラムの開発を深く理解できた。本実験はただ簡単に LWIP APP の

作成を説明しただけである。LWIP は UDP、TCP 等のプロトコルを完成できる。続きの教程にこち

らはイーサねに基づく具体的な APP を提供する。例えば、イーサネットを通じて、ADC が集めた

データを伝送することとか、カメラデータを上位機械に伝送することとか。 
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第十一章 ユーザー定義 IP テスト 

実験用 Vivado プロジェクトは“custom_pwm_ip”。 

 

 オフィシャル Xilinx はたくさんの IP コアを提供した。Vivado の IP Catalog にこれら

の IP コアを見ることができる。ユーザーは自分のシステムを構築する時、オフィシャル

Xilinx のフリーIP コアだけを使うのができない。ユーザー自身の IP コアを作成するときこ

とが必要で、いい点もある。例えば、システムデザインをカスタマイズする；デザインを重

複に使用できる。IP コアに license を追加して、有料で提供する；システムデザインをシン

プルにして、デザイン時間も縮める。ZYNQ システムで IP コアをデザインするには、よく使

われているのが AXI バスで PL と PL 部分の IP コアを接続することである。本実験は Vivado

に AXI バスタイプの IP コアを構築する方法を紹介する。この IP コアは PWM を生成して、開

発ボード上の LED をコントロールし、呼吸ライトの効果をつくる。 

 

11.1 PWM 紹介 

 

PWM はよく LED やブザーなどのコントロールに使われている。パルスのデューティ比を調節して

LED の明るさを調節する。開発ボードに使われた pwm モジュールは下のように：                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                    

////////////////////////////////////////////////////////////////////////////////

// 

// // 

// // 
//  Author: meisq // 
// msq@qq.com // 
// ALINX(shanghai) Technology Co.,Ltd // 

// heijin // 
// WEB: http://www.alinx.cn/ // 
// BBS: http://www.heijin.org/ // 
// // 
////////////////////////////////////////////////////////////////////////////////

// 
// // 
// Copyright (c) 2017,ALINX(shanghai) Technology Co.,Ltd // 

// All rights reserved // 
// // 
// This source file may be used and distributed without restriction provided

 // 
// that this copyright statement is not removed from the file and that any // 
// derivative work contains the original copyright notice and the associated

 // 
// disclaimer. // 
// // 

////////////////////////////////////////////////////////////////////////////////

// 

 

//==============================================================================

== 

//  Description:  pwm model 

//  pwm out period = frequency(pwm_out) * (2 ** N) / 

frequency(clk); 
// 
//==============================================================================

== 
//  Revision History: 
// Date By Revision Change Description 
//------------------------------------------------------------------------------

-- 
// 2017/5/3 meisq 1.0 Original 
//******************************************************************************
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**/ 
` 

timescale 1ns / 1ps 
module ax_pwm 
#( 

parameter N = 32 //pwm bit width 
) 
( 

input clk, 

input rst,  

input[N - 1:0]period,  

input[N - 1:0]duty, output

 pwm_out 

); 

 

reg[N - 1:0] period_r; 

reg[N - 1:0] duty_r; 

reg[N - 1:0] period_cnt; 

reg pwm_r; 

assign pwm_out = pwm_r; 

always@(posedge clk or posedge rst) 

begin 

if(rst==1) 
begin 

period_r <= { N {1'b0} }; 
duty_r <= { N {1'b0} }; 

end 

else begin 

period_r <= period; 

duty_r  <= duty; 

end 

end 

always@(posedge clk or posedge 

rst) begin 
if(rst==1) 
period_cnt <= { N {1'b0} }; 

else 

period_cnt <= period_cnt + period_r; 

end 

always@(posedge clk or posedge rst) 

begin 

if(rst==1) 

begin 

pwm_r <= 1'b0; 

end 

else 

begin 

if(period_cnt >= duty_r) 

pwm_r <= 1'b1; 
else 

pwm_r <= 1'b0; 
end 

end 
 

endmodule 
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   この PWM モジュールは“period”、“duty”という二つのパラメータを利用して、頻度と 

   デューティ比をコントロールする。レジーをデザインしてこれらのパラメータをコント 

   ロールする。ここは AXI バスを使用して、レジスターのリードライトをする。 

 

11.2 Vivado プロジェクトの作成 

11.2.1 一つの vivado プロジェクトを作成 

 

“custom_pwm_ip”という名のプロジェクトを作成する。zynqPS システムを追加して、パラメー

タを配置する。具体な方法は前の章に参考できる。 

 
 

11.2.2 ユーザー定義 IP を作成する。 

1) メニューの“Tools->Create and Package IP...”をクリックする。 

 

 

 

2) “Next を”を選択する。 

 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  140  

 

 

3) 新規 AXI4 デバイスを作成する。 

 

 

 

4) ネームは“ax_pwm”にして、デスクリプションは“alinx pwm”にする。そして、適切な位置を

選んでIPを入れる。 
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5) 下のパラメータはインタフェースタイプやレジスターの数とかを指定できる。ここは変更  

せずに、 AXI Lite Slave インタフェースとレジスター4つを使う。 

 

 

6) “Finish”をクリックして、IP の作成を完成する。 
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  7) “IP Catalog”に先程作成した IP が見える。 

 

8) この時の IP は簡単なレジスターをリードライトする機能しかないので、IP を変更する必要あ

る。IP を選択して、右ボタンで“Edit in IP Packager”を探し出す。 
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9) ダイアログがポップアップされて、プロジェクトネームとパスを書き込める。ここはど 

   こデフォルト値にして、“OK”をクリックする。 

 

 

10)   Vivado は新しいプロジェクトを開いた。  
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11)    PWM 機能のコアコードを追加する。 
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12)   コード追加する時、コードを IP 目次ぐにコピーする。 

 

 

 

13)   “ax_pwm_v1_0.v”を変更し、 pwm アウトプットポートを追加する。 

 

 

 

14)   “ax_pwm_v1_0.v”を変更し、インスタンス化“ax_pwm_V1_0_S00_AXI”に pwm ポート 

    のインスタンス化を追加する。 
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15)  “ax_pwm_v1_0_s00_AXI.v”ファイルを変更して、pwm ポートを追加する。この

ファイルは AXI4 Lite Slave を実現するコアコードである。 

 

 

 

16)  修改“ax_pwm_v1_0_s00_AXI.v”ファイルを変更して，pwm 機能コアコードをインス

タンス化にする。レジスター slv_reg0 と slv_reg1 を pwm モジュールパラメータのコント

ロールに用いる。 
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17) “component.xml”ファイルをダブルクリックする。 

 

 

18) “File Groups”オプションに“Merge changers from File Groups Wizard” 

     をクリックする。
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19) “Customization Parameters”オプションに“Merge changes form 

Customization Parameters Wizard”をクリックする。 

 

 

 

 

20) “Re-Package IP”をクリックして、IP の変更を完成する。 
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11.2.3 ユーザー定義 IP をプロジェクトに追加する 

 

1) “pwm”をサーチし、“ax_pwm_v1.0”を追加する。 

 

 

2) “Run Block Automation”W クリックする。
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3) “Run Connection Automation”をクリックす

る。 

 

4)  pwm ポートをエクスポート。 
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5)  HDL ファイルを作成する。 

 

 

 

6)  xdc ファイルを追加して、Pピンを分配する。 pwm_0 アウトプットポートを PLLED1 に 

     配って、呼吸ライトを作る。  

 

 
set_property IOSTANDARD LVCMOS33 [get_ports 

pwm_0] set_property PACKAGE_PIN M14 [get_ports 
pwm_0] 
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7)  bit ファイルを生成する。 

11.3 SDK ソフトのプログラミングとデバッグ 

1) ハードウェアをエクスポートする。 

 

2) SDK 起動する。 
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3) 新規 APP を作る。テンプレートは“Hello World”を選ぶ。 

日
昇
テ
ク
ノ
ロ
ジ
ー

https://www.csun.co.jp/


 不可能への挑戦        株式会社日昇テクノロジー         低価格、高品質が不可能？ 

日昇テクノロジーなら可能にする 

ホームページ：https://www.csun.co.jp         メール：info@csun.co.jp  154  

 

 

 

4) 前の例はすべて xilinx の IP を使っている。xilinx だいたい API を一セットで提供して 

    いる、ユーザー定義 IP の場合、自分で開発するには必要がある。APP の目次ぐにあるい 

      は資源を見て、ax_pwm.h というファイルが見つかる。このファイルにユーザー定義UOレジス 

         ターのリードライトマクロ定義を含んている。 日
昇
テ
ク
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5)   bsp に“xparameters.h”ファイルを見つける。これは非常に大事なファイルで、 

    ユーザー定義 IP とこの IP にあるレジスターのベースアドレスが見つかる。 

 

 

 

6)  レジスターリードライトマクロとユーザー定義 IP のアドレスがあって、コーデ

ィングをはじめる。ユーザー定義 IP をテストにするには、レジスター

AX_PWM_S00_AXI_SLV_REG0_OFFSET をライトすろことで、， PWM のアウトプット頻度を

コントロールする。そして、レジスターAX_PWM_S00_AXI_SLV_REG1_OFFSET をライトす

ることで、 PWM アウトプットのデューディリ比をコントロールする。 
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unsigned int duty; 

 

int main() 
{ 

init_platform(); 

print("Hello 

World\n\r"); 

//pwm out period = frequency(pwm_out) * (2 ** N) / frequency(clk); 

AX_PWM_mWriteReg(XPAR_AX_PWM_0_S00_AXI_BASEADDR, 

AX_PWM_S00_AXI_SLV_REG0_OFFSET, 
17179);//200hz 

 
while (1) { 

for (duty = 0x8fffffff; duty < 0xffffffff; duty = duty + 100000) 

{ AX_PWM_mWriteReg(XPAR_AX_PWM_0_S00_AXI_BASEADDR, 

AX_PWM_S00_AXI_SLV_REG1_OFFSET, 
duty); 

usleep(100); 
} 

} 
 

cleanup_platform(); 
return 0; 

} 

7) コードを作動することで、 PLLED1 が 呼吸ライトの効果を表現している。 
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8) debug を通じて、レジスターの状況を見てみよう。 
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9) debug 状態に入って、“F6”を押すと、シングルステップができる。

 

 

10)   メニューから Window→Show View→Memory をクリックする。 
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11) 監視アドレス“0x43c00000”を追加する 

    

 

12) ステップづつ実行して観察する。 
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11.4 実験結果 

本実験より SDK のデバッグ方法を勉強して、ARM と FPGA のデータ交換方法を把握する。 

 

11.5 よくある問題 

11.5.1 AXI IP のベースアドレスを調べる 

 

1) 下記図のように、“Address Editor”をクリックして、アドレス配分状況が分かる。 

 

 

2) 普通では Vivado が自動配分する。ユーザーもアドレスを修正できる。 
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第十二章 VDMA を使用して HDMI ディスプレイを駆動する 

 

 実験Vivadoプロジェクトはvdma_hdmi_outである。 

 

 PSには統合されたディスプレイ制御システムがなく、PLを使用して実現する必要がある。実現の方法はい

くつかあるが、どれでもDMAシステムが必要である。DMAシステムは、ddr3からディスプレイへの表示を完了

し、CPUオーバーヘッドを削減できる。VDMAは、ビデオ出力専用のxilinxが開発した特別なDMAであり、

xilinxFPGAビデオ処理を学習する重要な部分である。 

 前のHDMI表示データはPLによって内部に生成されているが、この実験では、PSによって表示データが生成

され、VDMAを介してPLがHDMIインターフェイスに送信される。 

 

12.1 Vivado プロジェクトの設立 

 

 VDMAディスプレイは重要な部分であるため、この実験ではVivadoビルドプロセスの詳細を説明する。 

 

1）vdma_hdmi_outというプロジェクトを作成する。 

 

2）新しい Block デザインを作成する 
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3）デザイン名はそのまま 

 

4）ZYNQ プロセッサを追加する 
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5）ZYNQ パラメーターをコンフィグし、VDMA 高速読み取り DDR3 の HPO インターフェイスを有効にする。 
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12.1.1 UART のコンフィグ 

Bnakレベル標準をコンフィグし、Bank0はLVCMOS 3.3V、Bank1はLVCMOS 1.8V、シリアルポートを有効にする 

 

 

12.1.2 12C EMIO のコンフィグ 

 

１）12COを有効にし、EMIOを選択して、12CをPL側に接続できるようにする。 
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２）クロックを設定し、FCLK_CLK0を100Mhzに、FCLK_CLK1を142MHzに設定し、このクロックの使用はVDMAデ

ータを読み取るためである。 

 
 

12.1.3 DDR3 のコンフィグ 

 

DDR Configurationタブで、PS端子ddrのパラメーターをコンフィグできる。AX7010コンフィグDDR3モデルは

MT41J128M16 HA-125、AX7020コンフィグDDR3モデルはMT41J256M16 RE-125である。ここでは、ddr3モデルは

ボード上のddr3モデルではない、パラメーターに最も近いモデルである。Effective DRAM Bus Width、32 Bit

を選択する。 
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12.1.4 コンフィグ割り込み 

割り込みの設定、IRQ_F2Pを有効にし、PL側で割り込みを受信  
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12.1.5 VDMA のコンフィグ 

１）VDMA IP を追加する 

 

 

２）以下に示すように、VDMA基本パラメーターをコンフィグする。 

 

 

３）VDMA高度なパラメーターのコンフィグ 
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４）ビデオタイミングコントローラーを追加する 

 

 

５）ビデオタイミングコントローラーパラメーターのコンフィグ 
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６）AXIストリーミングビデオ出力コントローラーを追加する 

７）AXIストリーミングビデオ出力コントローラーパラメーターのコンフィグ 
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12.1.6 カスタム IP を追加する 

 

１）ビデオには多くの解像度があるため、さまざまなクロック周波数が異なるため、ダイナミッククロック

コントローラーを使用する必要がある。このIPはオープンソースソフトウェアから提供されている。サンプ

ル内のrepoディレクトリを見つけて自分のディレクトリにコピーする。 

 

 

２）IPウェアハウスを追加する 
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３）追加が完了すると、多くのIPが表示される。 

 

 

４）ダイナミッククロックコントローラーを追加する 
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12.1.7 HDMI エンコーダーを追加する 
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１）Vivadoへの接続がクロック信号に自動的に接続しない場合がある 

 

２）他の重要な信号を接続する 
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３）割り込み信号に接続するには、最初に信号接続用のConcat IPを追加する必要がある。 
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４）Vivadoの自動接続機能を使用して、残りのケーブル接続を完成させる。 

 

 

５）すべてのモジュールを選択して自動的に接続する。 
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6）Run Block Automationを実行して、必要なポートエクスポートを完了する。 

 

7）ポートを選択して、エクスポート。 
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8）IIC_0ポートをエクスポート 

 

 

9）エンコーダーポートTMDSおよびOENのエクスポート 

 
 

10）別のポートの名前を変更する 
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11）設計後、F6を押して設計を確認し、問題なかったらHDLファイルを作成する。 

 

12）HDMI出力のxdcファイルを追加する。 
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13）xdcファイル内容は以下通りである。 

 

 

14）bitファイルのコンパイルと生成 
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12.2 SDK ソフトウェアの作成とデバッグ 

 

1）ハードウェアのエクスポート 

 
 

2）SDKを実行する 

 

   
3）vdma_hdmiというアプリを作成する 
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4）多くのプログラムファイルがあるため、具体的に紹介しなく、直接にサンプルのソースコードをコピ

ーする。srcディレクトリ内のファイルを削除し、代わりにサンプルのsrcディレクトリファイルを使用する。 
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5）SDKで更新する 

 

6）HDMI出力ポートをディスプレイに接続し、コンパイルして実行する。 

 

 

7）ディスプレイに画像が表示される 
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第十三章 プログラムの復帰 

 

 実験Vivadoプロジェクトはvdma_to_qspi_sdである。 

 

 JTAGデバッグを通して、SDカードにプログラムを書き込む、またはQSPI FLASHに書き込む方法について、

多くの実験を行った。まず、PLにはPSコンフィグが必要であるため、以前のFPDA書き込みのようにFlashに

直接書き込むことはできない。この実験では、プログラムを復帰する方法について説明する。 

 

13.1 Vivado プロジェクトの設立 

 この実験では、VDMAテストエンジニアリングを選択して復帰したが、VDMAテストプロジェクトを設立する

際、QSPIおよびSDカードを有効にできなかった。プログラムを復帰するには、QSPIまたはSDカードを有効に

する必要がある。 

 

1） プログラムの復帰テストのため、VDMAテストプロジェクトのコピーを保存し、名前を

vdma_to_qspi_sdに変更する。 

 

 

2） QSPIを追加し、MIO1-6を使用する。 
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3） SD0コントローラーを追加、MIO40-45及びTFカードインターフェイスを使用する 
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4） SDカードの検出ピンMIO47を追加する 

 

 

5） デザインを保存、bitファイルをコンパイルして生成し、ハードウェアを再度エクスポートする。 

 

13.2 FSBL を生成する 

 

 FSBLは、MIOの割り当て、DDRコントローラーの初期化、SD、QSPIコントローラーの初期化を完了し、FPGA

をコンフィグして、ユーザープログラムを読み込むセカンダリブートローダーである。 

 

1）SDKソフトウェアを起動する。SDKソフトウェアは他のプロジェクトからコピーしてきたため、以前

のSDKプロジェクトであり、パスの変更により、もう1つのhw_platform_1がある。 
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2）fsblという新しいアプリを作成し、ハードウェアプラットフォームに最新のプラットフォームを選

択する。 
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3）テンプレートはZynq FSBLを選択する。 
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4）デバッグマクロ定義FSBL_DEBUG_INFOを追加すると、FSBLの出力ステータス情報を開始できる。これ

はデバッグには役立つが、起動時間が長くなる。 
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5）SDKはデフォルトで自動的にコンパイルされ、fsbl.elfファイルが生成される。 

 

13.3 BOOT ファイルを作成する 

 

1） fsblプロジェクトを選択し、Create Boot Imageを選択する。 
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2） 生成されたBIFファイルパスは、ポップアップウィンドウに表示される。BIFファイルは、BOOTファ

イルを生成するためのコンフィグファイルであり、生成されたBOOT.binファイルパスである。BOOT.binファ

イルは、必要なスタートアップファイルであり、SDカードに入れることができ、 QSPI Flashにも書き込み

可能である。 
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3） Boot image partitionsリストに合成するファイルがあ。最初のファイルはbootloaderファイルで、

上記で生成されたfsbl.elfファイルである。2番目のファイルはFPGAコンフィギュレーションファイルであ

る。[Add]をクリックして、VDMAテストプログラムvdma_hdmi .elfを追加する。 
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4） [Create Image]をクリックして生成する。 
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5） BOOT.binファイルは、生成されたディレクトリにある。 

 

 

13.4 SD カードの起動テスト 

 

1） SDカードをフォーマットし、FAT32にフォーマットする。他のフォーマットは開始できない。 

 

 

 

2） BOOT.binファイルをルートディレクトリに入れる。 
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3） SDカードを開発ボードのSDカードスロットに挿入する。 

 

4） 開始モードをSDカードブートに調整 

 

 

 

5） HDMIディスプレイを接続し、ボードの電源を入れると、ディスプレイに子猫の写真が表示される。 

 

13.5 QSPI テスト開始 

 

1） SDKメニューの[Xilinx]-> [Program Flash] 
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2） Hardware Platformは最新のを選択、Image FIleファイルは書き込んだBOOT.binを選択、FSBL file

はコア電子カスタムの特別バージョンfsbl.elfを選択し、このfsblしか書き込めない 

 

 

3） [Program]をクリックして、プログラミングが完了するのを待つ。 

 

4） ブートモードをQSPIに設定して、もう一度起動すると、ディスプレイにディスプレイ出力が出てく

る。 

 

13.6 Vivado のもとで QSPI を書き込む 
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1） HARDWARE MANGERでデバイスを選択し、[Add Configuration Memory Device]をクリックする。 

 

 

 

2） Winbondを選択し、タイプをqspi、幅をx4-single入力すると、w25q128が表示され、開発ボードは

w25q256を使用、書き込みには影響がない。 
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3） 右クリックしてプログラミングファイルを選択する。 

 

4） 書き込みたいファイルとコア電子がカスタムのfsblファイルを選択すると、書き込みができる。書

き込む時、JTAGブートモードじゃないと、警告が出る。QSPIを書き込むときにJTAGブートモードを設定する

ことをお勧めする。 
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13.7 バッチファイルを使用して QSPI をすばやく書き込む 

 

1） 新しいprogram_qspi.txtテキストファイルを作成し、拡張名はbatに変更、コンテンツは次のように

入力する。Set XIL_CSE_ZYNQ_DISPLAY_UBOOT_MESSAGES = 1はプログラミングプロセス中にuboot印刷情報

を設定する。C:\Xilinx\SDK\2017.4\bin\program_flashはツールパス、インストールパスに従って変更する。 

-fは書き込むファイル、-fsblは書き込まれるfsblweファイル（コア電子特定のファイル）、-blank_check 

-verifyはチェックオプションである。 

 

 

2） 書き込むBOOT.bin、fsbl、batファイルをまとめる 
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3） JTAGケーブルを差し込んで電源を入れ、batファイルをダブルクリックしてflashを書き込める。 
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第十四章 仮想マシンと Ubuntu システムをインストールする 

 

 この後のマニュアルには、組み込みLinux開発が含まれ、通常、u-bootまたはLinux-kernelをコンパイル

するにはLinuxオペレーティングシステムホストが必要である。 Windowsオペレーティングシステムに仮想

マシンをインストールしてから、仮想マシンにLinuxオペレーティングシステムをインストールするのは一

番簡単な方法である。 

 

14.1 仮想マシンソフトウェアのインストール 

 

 私立ち提供する仮想マシンのインストールソフトウェアバージョンはVIMware-worksation-full12.1.1で、

ユーザーは提供された情報でそれを見つける。VIMware-worksation-full12.1.1-3770994.exeをダブルクリ

ックすると、インストールが開始される。 比較的簡単であるため、インストール手順は紹介せず、ユーザ

ーは[Next]ボタンをクリックするだけでインストールできる。 完了後のインターフェースに、VMware12の

シリアル番号を入力するためにライセンスを選択する必要がある。 

インストール完了後、デスクトップにVMware Workstation Proのアイコンが表示される。 

 

 

 

14.2 Ubuntu のインストール 

14.2.1 システムのインストール 

 仮想マシンをインストールしたら、仮想マシンにLinuxオペレーティングシステムをインストールする。 

Ubuntuデスクトップオペレーティングシステムのインストールが簡単のため、ubuntuデスクトップオペレー

ティングシステムを選択した。 

 このマニュアルでは、Ubuntu 16.04.3 LTS 64ビットオペレーティングシステムを使用する。 

 他のバージョンを使用している場合、予期しないエラーが発生する可能性があるから、バージョンの一貫

性を維持してください。システムをアップグレードしないでください。 

 Ubuntuのインストール手順は次のとおりである。 

 

1） デスクトップのVMware Workstation Proのアイコンをダブルクリックし、VMwareの作業インター

フェイスで[新しい仮想マシンの作成]アイコンをクリックする。 
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2） 次のステップを選択してください。 

 

 

3） 「Installer CD Image（iso）」アイテムを選択し、ダブルクリックしてubunt CDイメージファイ

ルubuntu-16.04.3-desktop-amd64.isoを見つける。 

4） 仮想マシンウィザードで、仮想マシンのフルネーム、ユーザー、およびパスワードを入力する。 こ

こでのフルネーム、ユーザー名、パスワードはユーザーが設定できる。 
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5） 仮想マシン名は変更できるが、十分な容量のあるディスクにインストールしてください。 
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6） 最大ディスクサイズを300Gに設定する。システムをインストールするため、ここのスペースを大

きくする必要がある。 ユーザーは、ハードディスクの空き容量に応じて適切な容量を選択できるが、300G

以上にすることをお勧めする。 
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7） カスタムハードウェアを選択する 
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8） 変更されたメモリサイズとプロセッサコア、ネットワークアダプタオプション、ネットワーク接

続に基づいてブリッジモードを選択できる。 

 

9） 「完了」をクリックして、インストールが開始する。 

 

10） 時間かかるから、しばらく待ってください。 
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11） インストール完了後、システムに入る。 
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14.2.2 ソフトウェアソースサーバーを変更する 

 

1）ソフトウェアを便利にインストールするには、ソフトウェアソースを設定し、システム設定をクリ

ックする。 

 

2）Software＆UpdatesにOtherを選択する。 
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3）[select best sever]をクリックして、最速のサーバーが出て、次に、choose serverを選択する。

これらの操作は、仮想マシンがインターネットに接続できるという事実に基づいている。 

 

4）パスワードを入力して、ソフトウェアソースの変更を完了する 
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14.2.3 bash をデフォルトの sh に設定する 

1） Ctrl + Alt + Tでターミナルを開く。 

 

2） Configuring dashコマンドを入力し、NOを選択し、Enterを押して確認する 

 
 

14.2.4 画面ロック時間を設定する 

Ubuntuシステムに大きなファイルをコピーできるように、画面ロックをキャンセルする。 
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14.3 よくある問題 

14.3.1 仮想マシンには仮想化サポートが必要である。 

1） Ubuntuをインストールし、次のエラーメッセージボックスが表示された場合、ユーザーはコンピュ

ーターを再起動し、BIOSに入ってセットアップする必要がある。 

 コンピューターを再起動した後、BIOSに入り、Intel仮想化を見つけて、[開く]をクリックする。 マザー

ボードによって名前が異なる場合がある。 
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第十五章 Ubuntu で Linux バージョンの Vivado ソフトウェアをインストールする 

 

 WindowsでのVivadoソフトウェアはほとんどの問題を解決できるが、場合によってはLinuxバージョンの

vivado、特にSDKを使用する必要があり、多くのアプリケーションをクロスコンパイルできる。 

 

15.1 Linux バージョンの Vivado をインストールする 

 

1） インストールファイルを仮想マシンのubuntuにコピーし、ファイルを抽出する。 

 
2） ターミナルを使用して、解凍されたファイルに入る 

 

3） コマンドを実行する。 
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4） コマンドを実行し、インストールを開始する。注意、ここはsudoインストールである。 

 

5） 以下のようなウィンドウが表示されたら、lgnoreをクリックする。 

 
6） インストールプロセスでは、ウイルス対策ソフトウェアをオフにする必要がある 
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7） 利用規約に同意する 
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8） Vivado HL Design Editionを選択する 

 
9） 必ずここでSoftware Development Kit(SDK)を選択してください。 
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10） インストールパスはデフォルトパスを使用する。 

 

11） Copy licenseをクリックしてlicファイルをインストールする。 
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15.2 許可設定 

 

 コマンドを実行して実行許可を追加する。 

 

 

15.3 ダウンローダードライバーをインストールする 

 

 次のコマンドを実行して、ダウンローダードライバーをインストールする 

 

 

15.4 Vivado をテストする 

 

1） 以下のコマンドを実行して、Vivadoを起動する 
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2） ダウンローダーを仮想マシンに接続する 
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3） 開発ボードとダウンローダーを接続し、Open Hardware Managerでテストすると、通常の状態でチッ

プが見つかり、Vivadoおよびダウンローダードライバーが正常にインストールされていることがわかる。 

 

 

15.5 よくある問題 

15.5.1 Linux ダウンローダーのダウンロード時にプロンプトが表示される 

1） ハードウェアのテスト時に、ダウンローダーが見つかるが、エラーが表示される。 
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2） 一部のマザーボードでは、USB互換性を設定し、仮想マシンのUbuntuをオフにし、USB互換性をUSB3.0

に設定して、もう一度試してください。ダウンローダー使用できない場合は、Windowsバージョンでしかダ

ウンロードできない。 
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15.5.2 ZYNQ に合うクロスコンパイラ  

 

 Vivadoをインストール時にSDKをインストールしたため、SDKにはクロスコンパイラarm-linux 

gnueabihf-gccが含まれている。 
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第十六章 Petalinux ツールのインストール 

 

16.1 Petalinux の概要 

 

 Petalinuxは特別なLinuxカーネルではなく、開発環境設定用のツールセットであり、uboot、カーネル、

及びルートファイルシステムの設定作業負荷を軽減できる。Vivadoのエクスポートハードウェア情報から関

連ソフトウェアを自動的に設定できる。 

 特に注意が必要なのは、Petalinuxがシステムバージョンと設定に厳しいこと。その他のバージョンでシ

ステムを操作する場合、問題があったらご自身で解決してください。 

 

16.2 インストールに必要なライブラリ 

 

1) 以下のコマンドを実行して、ライブラリをインストールする 

 

2) Tftp serverを設定する。TFTPから起動する必要がない場合、この手順は選択せきる。 
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16.3 Petalinux をインストールする 

1) インストールのためにコマンドを実行、ユーザー名は「your_user_name」、たとえば、下の画像のalinx。 

 

2) 実行許可をインストールファイルに追加する。もちろんpetalinux-v2017.4-final-installer.runこ

のファイルは最初にシステムにコピーする必要がある 

 
3) インストールを開始する 

 

4) Enterキーを押してプロトコルコンテンツを確認できる 
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5) qを押してプロトコルコンテンツを終了する 

 

6) yを押して同意する 

 

7) Licenseはインストールプロセス中にポップアップ表示され、qを押して終了、yを押して同意する 
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第十七章 NFS サービスソフトウェアのインストール 

 NFS（Network FileSystem、インタネットファイルシステム）はSUN会社が開発した技術であり、1984年

に導入され、異なるマシンや異なるオペレーティングシステムでファイルを相互に共有する技術である。 

NFSはもともと異なるシステム間で使用するように設計されていたため、その通信プロトコル設計はホスト

オペレーティングシステムとは関係ない。 

 NFSサーバーとクライアントは、リモートファイルを使用する場合、mountコマンドを使用して、ローカル

ファイルシステムの下のリモートNFSサーバーにファイルシステムをマウントできる。 NFSサーバーによっ

て共有されるファイルまたはディレクトリは、/ etc / exportsファイルに記録されている。 

 組み込みLinux開発では、NFSがよく使用されるが、通常、ターゲットシステムはNFSクライアントとして

使用され、LinuxホストはNFSサーバーとして使用されている。 ターゲットシステムで、NFSを介してサーバ

ーのNFS共有ディレクトリをローカルデバイスにマウントし、サーバー上のファイルを直接に実行できる。 

システムドライバーモジュールとアプリケーションのデバッグには、NFSが非常に必要である。また、Linux

は、リモートNFSルートからシステムを直接起動できるし、NFSルートファイルシステムもサポートできる。

また、組み込みLinuxルートファイルシステムの調整および統合にも必要がある 。 

 

17.1 NFS サーバーをインストールする 

 

1) 次のコマンドでNFS サーバーをインストールする 

 

2) NFSの作業ディレクトリとして新しい作業ディレクトリを作成する。将来、このディレクトリにクロ

スコンパイルされたプログラムを配置できる。開発ボードはこのディレクトリ内のファイルを簡単に共有で

きる。 
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3) 次のコマンドを使用して/ etc / exportsファイルを編集し、NFSサービスパスをコンフィグする。 

 

4) 末尾に/ home / alinx / work *（rw、sync、no_root_squash、no_subtree_check）を追加し、NFS作

業ディレクトリに/ home / alinx / workディレクトリを作成する。 

 
5) 次のコマンドを実行して、rpcbindサービスを再起動する。 NfsはRPCプログラムで、使用する前にポ

ートをマップしてrpcbindで設定する必要がある。 

 

6) 次のコマンドを実行してnfsサービスを再起動する。 

 

 

17.2 NFS をテストする 
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1) 次のコマンドでNFSをマウントし、NFS作業パスを/ mntディレクトリにマウントする。 

 

2) / mntと入力して、新しテストディレクトリtestを作成する。/home/alinx/workディレクトリにtest

フォルダーが表示される。 

 
 

17.3 よくある問題 

17.3.1 NFS マウントできない 

 最初に、仮想マシンと開発ボードがネットワークセグメントであるかどうかを確認する。 

 

 ifconfigコマンドを使用して、仮想マシンのIPアドレスを表示する。次の図の例は、192.168.1.55、

192.168.1.55ネットワークセグメントである。開発環境にはDHCCPサーバーがあるため、仮想マシンのIPア

ドレスが自動的に割り当てられる。 このテキストでは、ネットワーク環境が異なるため、ネットワークの

コンフィグ方法については説明しない。ネットワークをコンフィグできない場合は、ネットワーク管理者に

相談してください。 

 

 

 シリアル端末でifconfigコマンドを使用して、開発ボードのIPアドレスが表示される。次の図の例は、

192.168.1、ネットワークセグメントは192.168.1.46である。IPがない場合、または開発ボードIPに異なる

ネットワークセグメントがある場合は、ネットワーク管理者に連絡してください。 
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 シリアルターミナルで仮想マシンにpingし、サンプルでpingする。 192.168.1.55  これは、仮想マシ

ンのIPが192.168.1.155であり、これをpingしてNFSを通常にマウントできる。 
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第十八章 Petalinux で Linux システムをカスタマイズする 

 

 実験Vivadoプロジェクトはlinux_baseである。 

 

 前のマニュアルでは、Petalinux環境を構築したが、このマニュアルでは主にPetalinuxの使用方法を示す。

この実験は、Linuxホストがインターネットに接続できた場合のみ完了できる。  

 

18.1 Vivado プロジェクト 

  

 Petalinuxを使用すると、組み込みLinuxシステムをカスタマイズするのに非常に便利である。Vivadoソフ

トウェアがハードウェア情報をエクスポートするだけで、その後、Petalinxはこの情報に従ってuboot、カ

ーネル、ファイルシステムなどをコンフィグする。vivadoプロジェクトの確立手順は、前の実験で説明した

ため、ここでは説明しない。 

 

1) Bitファイルのコンパイルと生成 

2) ハードウェア情報をエクスポートする 

 

3) vivadoのプロジェクトディレクトリに* .sdkディレクトリがあり、下に* .hdfファイルがある。この

ファイルには、petalinuxが使用するファイルが含まれている。 
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18.2 Petalinux でプロジェクトを作成する 

 

1) linux_base.sdkディレクトリをLinuxホストにコピーする 

 

2) ターミナルを開き、ディレクトリに入る。  

 なぜここにpeta_prjディレクトリがないのか、自分でディレクトリを作成する必要がある。次回マニュ

アルでディレクトリがあるのに、自分が場合、ご自身で作成してください。 

 

3) petalinux環境変数を設定し、次のコマンドを実行する。 
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4) 次のコマンドを実行して、vivado環境変数を設定する。 

 
5) 次のコマンドで、ax_petaという名前のpetalinuxプロジェクトを作成すると、petalinuxはax_petaと

いう名前のプロジェクトが自動的に作成される。 - は二つで、ご注意してください。 

 
 

日
昇
テ
ク
ノ
ロ
ジ
ー

http://www.csun.co.jp/


不可能への挑戦                                    株式会社日昇テクノロジー          低価格、高品質が不可能？ 

                                      日昇テクノロジーなら可能にする 

ホームページ：http://www.csun.co.jp  メール：info@csun.co.jp 234 

6) 次のコマンドを使用して,petalinuxディレクトリーに入る。 

 
 

7) 次のコマンドで、Petalinuxプロジェクトのハードウェア情報をコンフィグする。../linux_base.sdk

ディレクトリは、vivadoからエクスポートしたハードウェア情報である。 

 

 

8) ポップアップウィンドウでpetalinuxプロジェクトをコンフィグできる。コンフィグ後に再度コンフ

ィグしたい場合は、コマンドpetalinux-configを実行してコンフィグできる。 
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9) ubootおよびLinuxカーネルのソースは、オプションLinux Components Selectionで設定できる。デフ

ォルトでgithubにダウンロードされる。ダウンロードするにはインターネットとLinuxホストと接続する必

要がある。 このテストはデフォルト設定のまま。 

 

10) 周辺機器と起動モードは、オプションのSubsystem AUTO Hardware Settingsで設定できる。 
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11) Advanced bootable images storage Settingsオプションで、起動モードをコンフィグする。デバッ

グのため、ここでは、デフォルトでSDカードから起動のまま、もしQSPI flashから起動する組み込みLinux

を作成する場合は、ここでコンフィグできる。 

 

12) 完了した後も設定を維持する。この実験は基本的にデフォルト設定である。 
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13) コンフィグインターフェースを終了する 

 

14) しばらくお待ちください。 
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18.3 Linux カーネルをコンフィグする 

 

1) 次のコマンドでカーネルをコンフィグする。コマンドを実行したら、少し待ちください。 

 
2) しばらく待ってから、カーネルをコンフィグするためのコンフィグインターフェースがポップアップ

する。 
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3) コンフィグを保存して閉じる。 

 

18.4 ルートファイルシステムのコンフィグ 

 

 次のコマンドを実行して、ルートファイルシステムがコンフィグできる。この実験ではデフォルトのコン

フィグが維持される。 
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18.5 コンパイルする 

 

1) 次のコマンドで、uboot、カーネル、ルートファイルシステム、デバイスツリーなどをコンパイルす

る。 

 

 

 

2) コンパイル完了 
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18.6 BOOT ファイルが生成される 

 

次のコマンドを使用して BOOT ファイルが生成される。スペースと‐記号に注意してください。 

 

18.7 Linux をテストする 

 

1) プロジェクト images -> linux ディレクトリの BOOT.BIN と image.ub を SD カードにコピーする。コ

ピーする前に SD カードをフォーマットして、開発ボートに挿入し、開発ボードを SD カードブートに設定す

る。 
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2) シリアルターミナルを開き、開発ボードを起動する。 

 

 

3) root でログインし、デフォルトでパスワードは root、インターネットケーブルを接続した後（ルー

ターは自動 IP 取得をサポートする）、ifconfig コマンドを使用してネットワークステータスを確認できる。 
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18.8 よくある問題 
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18.8.1 Bad FIT kernel image format!が表示され、カーネルが起動できない。 

 
 

解決方法： 

 

 SD カードの fat32 を再度フォーマットし、ブートファイルを再配置する 

 

18.8.2 ファイルとコンフィグが保存できない 

 

 petalinux のデフォルトファイルシステムは RAM タイプであるため、保存できず、次のマニュアルで SD カ

ードタイプに設定し、データは SD カードに保存できる。 
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第十九章 SDK で Linux プログラムを開発する 

 

 前のマニュアルでは、petalinux を使用して組み込み Linux システムを作成したが、この実験は Linux ア

プリケーションを作成し、開発ボード上で実行される。 この実験では、上記の実験で Linux オペレーティ

ング環境を使用する必要がある。 

 

19.1 SDK を使って Linux アプリケーションを作成する 

 

1) SDK ワークスペース用に/ home / alinx / work にディレクトリ linux_app を作成する 

 
 

2) Vivado の環境変数を設定して、SDK を実行する 

 

3) ワークスペースは/home/alinx/work/linux_app を選択する 
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4) Create Application Project を選択する 

 

 

5) プロジェクト名は hello を入力、OS Platform は Linux を選択する。 
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6) Build Project 

 

日
昇
テ
ク
ノ
ロ
ジ
ー

http://www.csun.co.jp/


不可能への挑戦                                    株式会社日昇テクノロジー          低価格、高品質が不可能？ 

                                      日昇テクノロジーなら可能にする 

ホームページ：http://www.csun.co.jp  メール：info@csun.co.jp 248 

 
 

19.2 NFS 共有を実行する 

 

1) 開発ボートにネットワークケーブルを挿入し（ルーターは自動的に IP を取得する必要がある）、電

源を入れ、LinuxホストNFSをマウントする。ホストIPは192.168.1.77、NFSディレクトリは/home/alinx/work、

/mnt は開発ボートのディレクトリである。ここでは、ホストと開発ボートが同じネットワークセグメント上

にある必要がある。 
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2) ディレクトリ/mnt/linux_app/hello/Debug に入り、hello.elf を実行する。Hello World がプリント

アウトしたことが分かる。 
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19.3 TCF-Agent を介してデバッグを実行する 

 

1) Linux Agent をダブルクリックして、接続パラメーターをコンフィグする。 

 

2) Host の IP アドレスを入力する。ここで入力するのは開発ボートの IP アドレスである。 
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3) Test Connection をクリックして、テスト接続が成功した場合、Linux TCF Agent サービスが実行さ

れており、デバッグを実行できる。 

 

4) プロジェクトを選択して、右クリックして実行する。 
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5) Debug ターミナルで HELLO WORD の出力を確認できる。 
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19.4 TCF-Agent 問題 

 

 TCF-Agent は Linux アプリケーションを簡単にデバッグできるが、NFS サポートも必要ない。しかし、複

数行プログラムのデバッグにはあまり適していない。アプリケーションがクラッシュした場合、デバッグ環

境の復元には役立たず、開発ボードを再起動する必要があるため、あまり使用されていない。 日
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第二十章 Linux 環境で GPIO 実験 

 

 前のマニュアルでは、SDk を使用して zynq バージョンの helloworld 実験をコーディングする方法につい

て説明した。この実験では、zynq のペリフェラルをコントロールする方法を紹介する。実験では、GPIO を

例として使用する。ZYNQ の GPIO は、二つのタイプがあって、一つは PS に付属する GPIO、1 つは PL で実装

された GPIO である。Vivado プロジェクトをビルドする時に、Xilinx の GPIO IP が追加される。Xilinx が提

供する IP コアのほとんどはすでに Linux でドライバがあって、しかも、使える。例えば、AXI GPIO ドライ

バはカーネルで再構成せずに使用できる。 

 

 この http://www.wiki.xilinx.com/Linux+Drivers サイドに、Linux 下のすべての Xilinx ドライバを見つ

ける。例えば、GPIO ドライバは以下のように、一部ドライバは詳しい使い方もある。 

 

 GPIOドライバの詳細ページhttp://www.wiki.xilinx.com/Linux%20GPIO%20Driverに GPIOドライバの使用

範囲、デバイスツリーの例、及びプログラムの作成方法が紹介されている。 

 

20.1 SHELL コントロールを使用する 

 

 Linux は強い SHELL 機能を提供しており、Linux を学習に必要な技能である。ZYNQ を勉強するには、しっ

かりと SHELL をマスターしないといけない。このマニュアルでは、Linux と SHELL の使用方法を紹介しない。 

 

 ls /sys/class/gpio コマンドで GPIO 番号を確認できる。 

 
 gpio_test.sh ファイル内容は以下通り、gpio_test 関数は、パラメーターに従って GPIO をエクスポート

し、次に for ループを 3回行う。最初に 0 を書き込み、次に 1を書き込み、gpio_test を 5 回呼び出してか

ら、5つの LED を点灯する。その中で、898 は PS 側で、その他は PL 側である。（次のセクションでは、GPIO

番号を確認する方法について説明する） 
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 NFS をマウントすることでこの SHELL を実行できる 

 

 SHELL が実行できない場合、先に実行許可を追加しておく。コマンドは次のとおり。 

 

 

20.2 C 言語を使ってコントロールする 

 

 ほとんどの場合、C言語を使用して周辺機器をコントロールする必要がある。Xilinx の Wiki ページ

http://www.wiki.xilinx.com/GPIO%20User%20Space%20App には、次の GPIO テストコードが見つかり、コー

ト内容は以下通り。 
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 今回はコンパイルに SDK を使用しない。ソースコードの名前を gpio.c にし、次のコマンドを実行してコ

ードをコンパイルする。 

 

 

 コンパイルが完了すると、gpio ファイルが生成される。Windows や Linux とは異なり、拡張名は厳しくな

い。gpio ファイルは elf ファイルである。 

 

 gpio を実行すると、ps 端子 LED が点滅していることがわかる。これは、この 898 が PS 側の最初の LED で

あることを示している。 

 

 

20.2.1 GPIO のコードの確認 

 

 次のコマンドを実行すると、gpiochip898 gpiochip1016 gpiochip1020 が表示される。これは、3つの GPIO

コントローラーがあることを示し、数字はコントローラーGPIO の基数である。 

 

 

20.2.2 物理 GPIO との関係の確認 

 

 次のコマンドで、GPIO1016 と物理 GPIO の関係を確認する。デバイスツリーの gpio のノードは/ amba_pl / 

gpio @ 41210000 であることがわかる。デバイスツリーのノードでどの物理 GPIO を確認できる。 
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20.3 実験のまとめ 

 

 この実験の焦点は、Xilinx から提供された情報を通して ZYNQ を学習すること。技術資料は迅速に更新さ

れ、チップメーカーから提供された最新の情報を入手して最新最高の技術を取得できる。 フォローアップ

マニュアルでは、PCle ドライバと PL 側イーサネットドライバが Xilinx から提供されている、これらの資料

は wiki で入手できる。 

 

 非 xilinx IP または独自の IP を使用する場合、独自のドライバを開発する必要がある。これは、Linux ド

ライバを実行していない開発者にとっての課題であるため、Xilinx の IP を使用してシステムを構築したほ

うがお勧めである。 利点は、Linux ドライバを開発する必要がないこと、欠点は、十分な柔軟性がないこと。

もし、IP に問題がある、または、ドライバに問題がある場合、問題をすばやく見つけることができない。 
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第二十一章 Petalinux での HDMI ディスプレイ 

 

 前のマニュアルで、Petalinux で組み込み linux システムを開発するのを体験したが、使う機能は

Petalinux のただ一部である。この実験では、独自のカーネルを使用して Linux を実行する方法を紹介する。

これにより、HDHI ディスプレイなど、多くのドライバをカーネルに追加できる。 

 

 開発ボードは HDMI インターフェイスチップを使用せず、PFGA を使用してエンコードを完了し、Core 

Electronics は Xilinx が提供するカーネルに HDMI コード化 IP ドライバを追加した。 その他のバージョン

を使用するソフトウェア開発者に、このマニュアルでは変更された linux-xlnx-xilinx-v2017.4 カーネルの

みを提供し、他のバージョンの変更されたバージョン、および変更手順が提供されていないことを注意して

ください。 

 

21.1 Petalinux のコンフィグ 

 

 この実験は、前のPetalinuxプロジェクトの実験で変更する。前の実験コンテンツを習得する必要がある。 

 

1) カーネルソースファイルを Linux ホストにコピーして、次に解凍する。解凍後のカーネルディレクト

リはこの実験 Petalinux に使うカーネルである。 

 
2) ターミナルを開き、前の実験中の Petalinux プロジェクトディレクトリに入る。 

 

3) Petalinux 環境変数を設定して、下のコマンドを実行する。 
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4) 下のコマンドを実行して、vivado 環境変数を設定する。 

 

 

5) 下のコマンドで Petalinux をもう一回コンフィグする。 

 
6) Linux Components Selection ---> linux-kernel (linux-xlnx) --->を選択する。 
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7) ext-local-src を選択してスペースキーを押す 

 
 

8) External linux-kernel local source settings --->を選択する。 
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EXternal linux-kernel local source path を選択する。 

 

 

9) Linux カーネルソースコードのパスを/home/alinx/work/linux-xlnx-xilinx-v2017.4 入力する。実際

のパスはカーネルの場所によって異なる。ここに例を示す。 
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10) 保存して閉じる。 

 

 

21.2 Linux カーネルをコンフィグする 

 

1) 下のコマンドを実行してカーネルをコンフィグする。 
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2) ポップアップウインドウが表示され、Device Drivers→Graphics support に入り、Digilent VGA/HDMI 

DRM Encoder Driver を選択してｙをｓ押す。 

 

3) Device Drivers ɒ Common Clock Framework オプションから Digilent axi_dynclk Driver を選択して

ｙを押す。 
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4) 保存して閉じる。 

 

 

21.3 デバイスツリーを変更する 

 

 デバイスツリーは、デバイス情報を記述するフォーマットされたテキストの一種で、このテキスト構造は

XML や JSON に似ている。  

 

1) petalinux プロジェクトファイルで system-user.dtsi という名前のファイルを開く。 
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2) デバイスツリーの変更内容は以下通りである。 
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21.4 テスト petalinux プロジェクトのコンパイル 

 

1) 下のコマンドで、uboot、カーネル、ルートファイルシステム、デバイスツリーなどをコンパイルす

る。 
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2) 下のコマンドを実行して BOOT ファイルを作成する。スペースとハイフンに注意してください。 

 

 

3) BOOT.bin と iamge.ub を SD カードにコピーして、開発ボードを SD モードで起動するように設定し、

HDMI ディスプレイを接続して、開発ボードを起動する。 

 
 

4) ディスプレイに以下の内容が表示される。 
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21.5 よくある問題 

 

21.5.1 システムのスリープを防ぐ方法 

 

スリープ前にコマンドを実行する。 
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第二十二章 Debian デスクトップシステムの使用 

 

 前のマニュアルで Petalinux で組み込む Linux システム及び HDMI ディスプレイを作成する方法を紹介し

た。この実験では、Debian に基づいてルートファイルを作成する。ルートファイルシステムの作成が複雑の

ため、この章では説明しない。生成された Debian ルートファイルシステムを直接使用する 。 

 

22.1 Petalinux のコンフィグ 

 

 Debian ルートファイルシステムが大きいのため、QSPI flash には保存できず、SD カードまたは emmc にし

か保存できない、だから、Petalinux をコンフィグする必要がある。 

 この実験は、前の Petalinux プロジェクトの実験をまだ変更するため。以前のテストコンテンツをマスタ

ーする必要がある。 

 

1) ターミナルを開き、前の実験の Petalinux プロジェクトディレクトリに入る 

 

 

2) Petalinux の環境変数を設定し、下のコマンドを実行する。 

 

 

3) 下のコマンドを実行して vivado 環境変数を設定する 

  

 

4) 下のコマンドで Petalinux をもう一回コンフィグする。 
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5) Image Packaging Configuration --> Root filesystem type オプションから SD card を選択し、ルー

トファイルシステムを SD カードに置く。 

 

6) 保存して閉じる。 

 

 

22.2 linux カーネルをコンフィグする 

 

1) 下のコマンドを実行してカーネルをコンフィグする 
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22.2.1 USB WIFI モジュールドライバをコンフィグする 

 

1) Networking Support -> Wireless ->オプションの中から cfg80211 - wireless configuration API

を選択して、次に Generic IEEE 802.11 Networking Stack (mac80211)を選択する。 

 
 

2) Device Drivers -> Network device support -> Wireless LAN -> Realtek rtlwifi family of  

devices オプションから Realtek RTL8192CU/RTL8188CU USB Wireless Network Adapter を選択する。 
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22.2.2 USB カメラドライバをコンフィグする 

 

1) Device Drivers ---> Multimedia support ---> Media USB Adapters --->オプションの USB Video Class 

(UVC)を有効にする。 

 

 

2) 保存して閉じる。 

 

 

22.3 Petalinux プロジェクトのコンパイルとテスト 
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1) 下のコマンドを使用して、uboot、カーネル、ルートファイルシステム、デバイスツリーなどをコン

フィグする。 

 
 

2) 下のコマンドを実行して BOOT.BIN ファイルを生成する。スペースとハイフンを注意してください。 

 

 

22.4 SD カードファイルシステムを作成する 

 

 SD カードファイルシステムを作成するには SD カードの内容が失う可能性があるため、事前にバックアッ

プしてください。 

 

22.4.1 SD カードのパーティションを変更する。 

 

1) 開発ボードの SD カードをカードリーダーに挿入し、次にコンピューターの USB ポートに挿入する。 

 

2) 仮想マシン Linux に接続する 
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3) ubuntu の検索パスに disk と入力すると、Disks のアイコンが表示される。 

 

4) DIsks アイコンをクリックすると、DIsks のダイアログボックスが表示される。この実験で、SD カー

ドは、FAt と EXT という 2つのパーティションに分けているが、ここではもう一回分け直す。 
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5) 各パーティションの下のパーティション削除アイコンを選択し、すべてのパーティションを削除する。 

 
 

日
昇
テ
ク
ノ
ロ
ジ
ー

http://www.csun.co.jp/


不可能への挑戦                                    株式会社日昇テクノロジー          低価格、高品質が不可能？ 

                                      日昇テクノロジーなら可能にする 

ホームページ：http://www.csun.co.jp  メール：info@csun.co.jp 277 

 

6) ＋アイコンをクリックして最初のパーティションを追加する。この実験は 5000MB を入力し、フォー

マットは FAT で、ZYNQ のブートファイル BOOT.bin とカーネルファイル、及びデバイスツリーを保存するた

め、名前は FAT にする。 

 
 

7) ルートファイルシステムを保存するため、第二のパーティションを作成し、フォーマットを EXT4 に

し、名前を EXT にする。 
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8) パーティションを作成した後、SD カードを再挿入する。 

 

9) システムは自動的にパーティションをマウントし、ウィンドウをポップアップする 
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22.4.2 ルートファイルシステムを SD カード EXT4 パーティションに同期する。 

 

1) ルートファイルシステムの圧縮ファイルを Linux ホストにコピーする（実験を/ home / alinx / work

ディレクトリーにコピーする） 

 
2) 解凍コマンド sudo tar -zxvpf debian_rootfs.tar.gz を入力して、ファイルシステムを抽出する。

解凍には数分かかる場合がある。 解凍方法はマニュアルと一致する必要があることに注意してください。 

 

3) これらのファイルシステムのすべてのファイルを SD カードの EXT パーティションのルートディレク

トリにコピーする必要がある。コマンドウィンドウでコマンド cd debian_rootfs を入力して、ルートファ

イルシステムのディレクトリに入る。 

日
昇
テ
ク
ノ
ロ
ジ
ー

http://www.csun.co.jp/


不可能への挑戦                                    株式会社日昇テクノロジー          低価格、高品質が不可能？ 

                                      日昇テクノロジーなら可能にする 

ホームページ：http://www.csun.co.jp  メール：info@csun.co.jp 280 

 

4) コマンドウィンドウで、sudo rsync -av ./ / media / alinx / EXT（/ media / alinx / EXT を入力

し、これは SD カードの EXT4 パーティションのパスである。異なる場合があり、実際の状況に応じて変更し

てください。現在のディレクトリを SD カードの EXT パーティションのルートディレクトリに同期し始め、

同期には数十分かかる場合がある。 

 

5) コマンドプロンプトがコマンドラインに再表示されると、同期が終了する意味である。 

 

6) BOOT.bin と iamge.ub を SD の FAT32 パーティション（最初のパーティション）にコピーし、開発ボー

ドの sd モードを開始に設定し、HDMI ディスプレイを差し込み、開発ボードを開始する。 
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7) SD カードを作成したら、できた SD カードを開発ボードの SD カードスロットに挿入する。 USB シリ

アルケーブルを接続、HDMI ディスプレイを接続して、ボードの電源を入れた後、Debian オペレーティング

システムのインターフェースが HDMI ディスプレイに表示される。さらに、シリアルポートツールでは、オ

ペレーティングシステムを起動するプロセスも確認できる。u-boot を実行後、Linux の実行を開始する。ア

カウント：root、パスワード：root。 

 

 

8) システムに入ったら、ifconfig コマンドを使用してネットワーク接続を確認できる。 
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第二十三章 QSPI Flash から起動の Linux の作成 

 

 前のマニュアルで説明した Linux はすべて SD で開始するが、この実験では、Petalinux を使用して QSPI 

Flash から起動の Linux を作成する方法について説明する。 

 

 ここでは、ボード上の QSPI Flash サイズは 32M バイトだが、ZYNQ チップは 16MB しか使用できないため、

ZYNQ 自体によって決定してください。Linux システムは 16MB を超えると使えなくなる。 

 

23.1 Petalinux プロジェクトをコピーする 

 

 前のマニュアルでは、Petalinux を使用して SD カードのブートのさまざまな実験を行った。SD ブートプ

ロジェクトを保持したいが、新しいプロジェクトを作成したくないため、古いプロジェクトをコピーできる。 

1) プロジェクトディレクトリで、Ctrl + H を同時に押して、シャドウファイルが表示される。 

 
2) project-spec、.petalinux、config.project を新しいディレクトリにコピーして、新しい Petalinux

プロジェクトにする。 

 

日
昇
テ
ク
ノ
ロ
ジ
ー

http://www.csun.co.jp/


不可能への挑戦                                    株式会社日昇テクノロジー          低価格、高品質が不可能？ 

                                      日昇テクノロジーなら可能にする 

ホームページ：http://www.csun.co.jp  メール：info@csun.co.jp 284 

 

3) PL コンフィギュレーションの BOOT を合成するために、images / linux ディレクトリの bit ファイル

も新しいプロジェクトディレクトリにコピーする。 

 
 

23.2 Petalinux のコンパイルとコンフィグ 

 

1) 下のコマンドで環境変数を設定する 
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2) petalinux-config コマンドを使用して petalinux をコンフィグする 

 

 

3) Subsystem AUTO Hardware Settings ---> Advanced bootable images storage Settings ---> boot image 

settings ---> image storage media オプションから primary flash を選択する。 

 
 

4) Subsystem AUTO Hardware Settings ---> Advanced bootable images storage Settings --->kernel 

image settings ---> image storage media オプションから primary flash を選択する。 
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5) Subsystem AUTO Hardware Settings →Flash Settings は QSPI Flash のパーティションを変更でき

る。デフォルトはほとんど使用可能だが、ファイルサイズがデフォルトのパーティションサイズを超える場

合は、自分で調整する必要がある。 

 
6) Image Packaging Configuration ---> Root filesystem type に INITRAMFS を選択して、RAM タイプ

のルートファイルシステムを使用することにより、簡単にパッケージ化して QSPIflash に書き込むことがで

きる。 
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7) Firmware Version Configuration --->に Host name 等の情報を修正できる。 

 

8) コンフィグを保存する。 

9) コンパイル 
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10) 下のコマンドを使用して BOOT を合成する。以前のマニュアルとの違いは、-kernel オプションが追

加され、カーネルを BOOT.bin ファイルにパッケージ化することである。 

 

 

11) 第十三章を参照して、BOOT.bin を QSPIflash に書き込むことができる。 

12) 起動モードを QSPI に調整する 

 

 

以上。 
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